


BSBITU304
Produce spreadsheets

Release 1

Learner guide

Aspire Version 1.1

40spire

/ Iea rning resources



Copyright Warning

This product is copyrighted to Aspire Training & Consulting
(ABN 51 054 306 428).
Aspire Training & Consulting owns all copyright to its products. Except as permitted

by the Copyright Act 1968 (Cth) or unless you have obtained the specific written
permission of Aspire Training & Consulting, you must not:

reproduce or photocopy this product in whole or in part
publish this product in whole or in part
cause this product in whole or in part to be transmitted
store this product in whole or in part in a retrieval system including a computer
record this product in whole or in part either electronically or mechanically
resell this product in whole or in part.
Aspire Training & Consulting:
+ invests significant time and resources in creating its original products
protects its copyright material
will enforce its rights in copyright material

reserves its legal rights to claim its loss and damage or an account of profits made
resulting from infringements of its copyright.

Aspire is committed to developing quality resources that meet the needs of our customers. However,
occasionally Aspire finds, or is notified of, errors. Please refer to our website at www.aspirelr.com.au to see if
there are any updates that may be relevant to you.

Every effort has been made to ensure the information in this book is accurate; however, the author and
publisher accept no responsibility for any loss, damage or injury arising from such information.

Except where an information source is acknowledged, the names and details of individuals and organisations
used in examples are fictitious and have been devised for learning purposes only. Any similarity to actual
people or organisations is unintentional.

All websites referred to in this unit were accessed and deemed appropriate at time of publication.

Aspire Training & Consulting apologises unreservedly for any copyright infringement that may have occurred
and invites copyright owners to contact Aspire so any violation may be rectified.

BSBITU304 Produce spreadsheets Release 1
© 2017 Aspire Training & Consulting

Level 1, 464 St Kilda Road

MELBOURNE VIC 3004 AUSTRALIA

Phone: (03) 9820 1300

First published April 2017

Cover design: Rewind Creative
Printer: Doculink Australia Pty Ltd, 1d/28 Rogers Street, Port Melbourne VIC 3207

e-ISBN 978-1-76059-444-2 (PDF version)
ISBN 978-1-76059-443-5



Contact details

Participant

Name:

Start date:

Phone number:

Email:

Work location

Name:

Address:

Postal address:

Workplace supervisor name:

Phone number:

Fax:

Email:

Registered Training Organisation (RTO)

Name:

Address:

Postal address (if different):

Phone number:

Fax:

RTO contact name:

Mobile:

Email:







Contents

Before you begin vii
Topic 1: Prepare to use spreadsheets 1
1A Use safe work practices 2
1B Minimise wastage 18
1C Identify spreadsheet task requirements 21
Summary 32
Learning checkpoint 1: Prepare to use spreadsheets 33
Topic 2: Design a spreadsheet 37
2A Design a spreadsheet to suit the purpose and requirements of the task 38
2B Design a spreadsheet that is understandable and attractive 44
2C Use style sheets and automatic functions 48
Summary 59
Learning checkpoint 2: Design a spreadsheet 60
Topic 3: Create a spreadsheet 65
3A Enter, check and amend data 66
3B Format a spreadsheet 72
3C Use and test formulas and functions 76
3D Overcome problems with spreadsheet design and production 82
Summary 87
Learning checkpoint 3: Create a spreadsheet 88
Topic 4: Produce simple charts 93
4A  Select appropriate chart type and design 94
4B Create charts 103
4C Modify charts and layout 108
Summary 120
Learning checkpoint 4: Produce simple charts 121
Topic 5: Finalise spreadsheets 123
5A Preview, adjust and print spreadsheets 124
5B Meet data input time lines and quality requirements 131
5C Name and store spreadsheets and exit applications safely 134
Summary 139
Learning checkpoint 5: Finalise spreadsheets 140

Unit release 1 (Aspire Version 1.1)
© Aspire Training & Consulting






Before you begin

This learner guide is based on the unit of competency BSBITU304 Produce spreadsheets,
Release 1. Your trainer or training organisation must give you information about this unit
of competency as part of your training program. You can access the unit of competency and
assessment requirements at: www.training.gov.au.

How to work through this learner guide

This learner guide contains a number of features that will assist you in your learning. Your
trainer will advise which parts of the learner guide you need to read, and which practice
tasks and learning checkpoints you need to complete. The features of this learner guide are
detailed in the following table.

Feature of the
learner guide

Learning content

Examples and case
studies

Practice tasks

Video clips

Summary

Learning checkpoints

How you can use each feature

Read each topic in this learner guide. If you come across content that
is confusing, make a note and discuss it with your trainer. Your trainer
is in the best position to offer assistance. It is very important that you
take on some of the responsibility for the learning you will undertake.

Examples of completed documents that may be used in a workplace
are included in this learner guide. You can use these examples as
models to help you complete practice tasks and learning checkpoints.

Case studies highlight learning points and provide realistic examples of
workplace situations.

Practice tasks give you the opportunity to put your skills and knowledge
into action. Your trainer will tell you which practice tasks to complete.

Where QR codes appear, learners can use smartphones

. : : : [m] 7% ]
and other devices to access video clips relating to the ;; A
content. For information about how to download a QR FEL* ¥

reader app or accessing video on your device, please visit
our website: www.aspirelr.com.au/help

Key learning points are provided at the end of each topic.

There is a learning checkpoint at the end of each topic. Your trainer will
tell you which learning checkpoints to complete. These checkpoints
give you an opportunity to check your progress and apply the skills and
knowledge you have learnt.
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Foundation skills

As you complete learning using this guide, you will be developing the foundation skills
relevant for this unit. Foundation skills are the language, literacy and numeracy (LLN)
skills and the employability skills required for participation in modern workplaces and
contemporary life.

The following table outlines specific foundation skills noted for your learning in this
learner guide.
Foundation skill area Foundation skill description

Reading * Recognises and interprets numerical and textual information
to determine organisational and task requirements

Writing * |Inputs numerical and key reporting information when
creating and finalising spreadsheets and uses format, layout,
style guides and standard naming conventions to organise
data according to purpose and audience

Oral communication e Participates in exchange of information to determine whether
formulae utilised produce result required

Numeracy e Uses mathematical equations to create simple formulae and
validate numerical data

Navigate the world of work * Recognises and follows explicit and implicit protocols and
meets expectations associated with own role

Interact with others ¢ Collaborates with others to achieve joint outcomes

Get the work done e Uses advanced features within applications to address
routine and complex work tasks

Unit release 1 (Aspire Version 1.1)
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Before you begin

What do you already know?

Use the following table to identify what you may already know. This may assist you to work
out what to focus on in your learning.

Topic

Topic 1 Prepare to use
spreadsheets

Topic 2 Design a
spreadsheet

Topic 3 Create a
spreadsheet

1A

1B

1C

2A

2B

2C

3A

3B

3C

3D

Key outcome

Use safe work practices

Minimise wastage

Identify spreadsheet task
requirements

Design a spreadsheet to suit the
purpose and requirements of the
task

Design a spreadsheet that is

understandable and attractive

Use style sheets and automatic
functions

Enter, check and amend data

Format a spreadsheet

Use and test formulas and

functions

Overcome problems with

spreadsheet design and production

Rate your confidence
in each section

U Confident
U Basic understanding
U Not confident

1 confident
(] Basic understanding
L Not confident

U Confident
U Basic understanding
U Not confident

U Confident
U Basic understanding
U Not confident

U Confident
U Basic understanding
U Not confident

U Confident
U Basic understanding
1 Not confident

U confident
] Basic understanding
U Not confident

U Confident
U Basic understanding
U Not confident

1 confident
(] Basic understanding
L Not confident

U Confident
U Basic understanding
U Not confident
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Topic 4 Produce simple 4A Select appropriate chart type and U confident

charts design U Basic understanding

U Not confident

4B Create charts U Confident

U Basic understanding
U Not confident

4C Modify charts and layout U confident

U Basic understanding
U Not confident

Topic 5 Finalise 5A Preview, adjust and print U confident

spreadsheets spreadsheets Q Basic understanding

U Not confident

5B Meet data input time lines and W confident

quality requirements Q Basic understanding

U Not confident

5C Name and store spreadsheets and [ Confident

exit applications safely O Basic understanding

U Not confident
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Topic 1
Prepare to use spreadsheets

A spreadsheet is a very useful computer application that makes it easy to carry out repetitive
tasks involving numbers. Organisations use spreadsheets to store and calculate numerical
data such as financial statements or product pricing information. Setting up a spreadsheet is
a simple form of computer programming. Most people in business, or working in an office,
will be expected to use and produce spreadsheets.

Once you have created a spreadsheet, you need to format it to make the information it
contains easy to understand. When formatting a spreadsheet you may need to ensure the
spreadsheet complies with the organisation’s style guidelines.

In this topic you will learn how to:

1A Use safe work practices

1B Minimise wastage

1C Identify spreadsheet task requirements

Unit release 1 (Aspire Version 1.1)
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1 A Use safe work practices

Workplace safety is everyone’s responsibility. Employers and employees must make an active
contribution to ensuring their workplace is safe. Hazards need to be identified and risks
assessed to reduce injury in the workplace. If you are working at a computer for an extended
period each day, your workstation must be comfortable and designed for you to carry out
your tasks efficiently. You will need to organise your work so that you are not doing a
repetitive task for a long time. You should also take time to stand up and stretch.

Another consideration in the workplace is to use resource conservation techniques to
prevent wastage. Most organisations
require staff to follow resource-saving
procedures such as turning off lights
in unused rooms and recycling

paper. You need to be aware of any
conservation efforts made by your
organisation.

Workplace
safety legislative
requirements

All work health and safety (WHS)
legislation requires employers

to provide a safe workplace and adequate training and supervision, while controlling
workplace hazards and risks. You must work in line with legislative requirements,
regulations, Australian and industry standards, and the relevant codes of practice.

WHS legislation describes the legal requirements for ensuring workplaces are safe and
healthy, such as:

« managing risks to health and safety

« promoting and maintaining the health, safety and welfare of people at work

« protecting people at work from injury and illness, including psychological injury
« protecting the health and safety of the public in workplaces

« consulting workers and encouraging participation in maintaining WHS

« providing rehabilitation and maximum recovery for injured workers.

WHS policy

All workplaces in Australia are required to have a WHS policy that describes the
organisation’s responsibility for the health and safety of its employees. The policy should
include the organisation’s goals and objectives regarding WHS and a general set of
guidelines related to health and safety in the workplace.

The WHS policy will help you fulfil your duty of care as a worker for the organisation.

Unit release 1 (Aspire Version 1.1)
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WHS procedures

WHS procedures are instructions developed to ensure all employees work safely and
effectively. In the context of working in an office and using a computer workstation, the
following information should be contained in an organisation’s WHS procedures.
Information contained in WHS procedures includes:

» workstation ergonomics

« standard safety precautions and housekeeping

« safe handling of hazardous substances (e.g. cleaning products)

o emergency and fire drills

« hazard identification and risk control

o manual handling

« emergency contact numbers, including local doctors and hospitals

o location of first-aid equipment and first-aid officers.

WHS regulations

The WHS legislation of each state or territory is supported by regulations and codes of
practice. The WHS regulations support the legislation by outlining specific workplace health
and safety requirements that must be addressed.

The Model WHS regulations, which provide a framework that most states and territories
have adopted, have specific requirements for hazardous manual tasks that must be
addressed. These requirements are summarised below.

Manage risk

A person conducting a business or undertaking must manage risks to health and safety
relating to a musculoskeletal disorder associated with a hazardous manual task, in
accordance with guidelines for managing risks to health and safety.

Control measures \

In determining the control measures to implement, the person conducting the business
or undertaking must have regard to all relevant matters that may contribute to a
musculoskeletal disorder, including:

* postures, movements, forces and vibration relating to the hazardous manual task
¢ the duration and frequency of the hazardous manual task

¢ workplace environmental conditions that may affect the hazardous manual task or
the worker performing it

¢ the design of the work area
¢ the layout of the workplace
* the systems of work used

* the nature, size, weight or number of persons, animals or things involved in carrying
out the hazardous manual task.

\_ /
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Code of practice: hazardous manual tasks

The WHS regulations determine that it is a legal requirement for the person conducting a
business or undertaking (PCBU) and workers to address hazardous manual tasks in the
workplace. A PCBU has a broad definition that includes both employers and supervisors.

The code of practice for hazardous manual tasks was developed to provide guidance
on how to manage risks associated with those manual tasks with the potential to cause
musculoskeletal disorders (MSDs).

A PCBU must consult with workers, so far as it is reasonably practical, to develop their own
set of procedures to manage the risk of MSDs.

The hazardous manual tasks code of practice helps PCBUs and workers to:

 identify hazardous manual tasks

o assess the risks

o control the risks

o review the control measures.

Musculoskeletal disorders

MSDs come about in two main ways:

o Gradual wear and tear to joints, ligaments, muscles and inter-vertebral discs through
repeated or continuous use of the same body parts, including static body positions

« Sudden damage caused by strenuous activity or unexpected movements, such as when
loads being handled move or change position suddenly

The repetitive movements and sustained body position associated with entering data into a
computer is regarded as a hazardous manual task and puts the operator at risk of developing
an MSD.

MSDs may include conditions such as:

» sprains and strains of muscles, ligaments and tendons

» backinjuries, including damage to the muscles, tendons, ligaments, spinal discs, nerves,
joints and bones

 joint and bone injuries or degeneration, including injuries to the shoulder, elbow, wrist,
hip, knee, ankle, hands and feet

« nerve injuries or compression (e.g. carpal tunnel syndrome)
« muscular and vascular disorders as a result of hand-arm vibration
o soft tissue hernias

o chronic pain.

4
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Standard precautions

Your workplace may need you to use standard
precautions, particularly work practices related to the
prevention of repetitive strain injuries (RSIs). These
include ergonomic practices, workstation design, enforced
breaks and exercise routines.

Workers in an office environment follow standard
precautions when using a computer workstation.
However, research on sitting has demonstrated that
other precautions also need to be considered, such as
the use of standing workstations, to ensure that injuries
are prevented. It is important that you carefully follow
any standard precautions that are prescribed for your
workplace.

Equipment and systems
safety checks

An important part of your daily work routine is to check the various systems and equipment
you will use during the day to make sure they are in correct working order. Your workplace
policies and procedures should include the steps to follow. You may need to perform this
procedure at the start of your working day or at specified intervals during the day.

Workstation safety procedure/checklist:

« Seat is positioned in front of your computer and you can reach your keyboard
comfortably.

« Computer monitor is positioned out of direct sunlight and at the correct height.

o Environment is dust-free as dust can affect the monitor or central processing unit of a
computer.

o Cables are secured so no-one trips over them.
« Blinds and window coverings are used to reduce glare and heat at your workstation.
o Temperatures don’t exceed 26°C and humidity is between 40 and 60 per cent.

Use ergonomic practices in the workplace

The aim of ergonomics is to reduce the risk of accidents, injury
and ill health by applying safe work practices. Ergonomics is
about creating comfortable working conditions by adapting
workstations, tools and equipment to an individual worker’s
needs. It also improves performance and productivity in the
workplace. Ergonomics covers all aspects of working, from
physical stresses such as sitting at a workstation all day

to environmental factors such as noise, air-conditioning

and lighting.

Unit release 1 (Aspire Version 1.1)
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Set up your workstation

A workstation includes a computer, screen, keyboard, mouse, desk and chair. How your
workstation is designed can affect your health and wellbeing. Several physical problems can
result from poor workstation design; for example, lower back strain may result from sitting
in a chair that does not support your back. Below are some guidelines for setting up your
workstation to be ergonomically efficient.

Chair \

Adjust your chair height so that your feet are flat on the floor, your
thighs are horizontal and your lower legs are vertical to the floor.

Adjust the backrest by raising it to the maximum height and

then lower it until it fits the curve of your lower back. If this is not
comfortable, lower it another couple of centimetres. Continue this
until a comfortable position is found. The backrest should support
your lower back.

The backrest may also be adjusted backwards and forwards.
When seated in your usual working position, move the backrest
until it exerts a gentle pressure on your lower back. Make sure
there is at least two centimetres of space between the front of the
seat and the back of your knees. Armrests should be positioned so
that they do not interfere with carrying out your tasks.

\_ /

Desk \

When you sit at your desk, the surface should be just below your
elbow height. If your desk is not height-adjustable, try to raise your
chair so you are sitting at the correct height, and use a footrest to
make up the difference. If your desk is too low, you may be able to
extend the legs. You should have plenty of leg space underneath
your desk. Don’t clutter the space with bags and bins, as your
legs may become cramped and your posture twisted. Position any
equipment or materials you use so that you can reach them easily
without twisting. For example, stationery items you frequently use
should go in the top desk drawer, and your keyboard and screen
should sit directly in front of you to avoid having to angle or twist
your body.

/
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Keyboard N\

The angle of your keyboard can be adjusted to suit your comfort
level by moving the supports underneath it. Place the keyboard as
close as possible to the front of your desk. Don’t place documents
between yourself and the keyboard, as stretching will eventually
cause muscle strain in your arms, shoulders and neck. While
typing it is best not to rest your wrists, as they should not be bent
up, down, or to the side. The knuckle, wrist and top of the forearm
should form a straight line. Wrist supports or rests give you a place
to rest your hands only when pausing from typing, not while you
are typing. Do not pound the keys; use a light touch. Leave enough
room on your desk to put the keyboard out of the way when you
are not using it.

/

Mouse \

Place the mouse and mouse mat directly beside your keyboard on
the side you prefer. If you use the mouse frequently, you could try
to alternate sides. You will be surprised at how easy this becomes
with practice. Your wrist should be straight, and the desk should
support the weight of your wrist, not your arm. Try to keep your
wrist flat and rest your fingers on the mouse between clicks. Hold
the mouse lightly. Don’t hold onto the mouse when you are not
using it.

\_ /

Screen \

Once you have adjusted your chair and desk, you can position
your screen. Adjust it so that the top of the screen is level with or
slightly lower than your eyes. If you can’t adjust the screen to the
correct height, place the screen on a platform.

The screen should be at least 50 centimetres or an arm’s
length away from your seated position to minimise radiation
exposure; however, you should always adjust the position of the
screen to suit you. It is best to position the screen so that you
can clearly read the text without leaning forward, twisting your
neck, or looking too far upwards. Also take surrounding factors
into consideration, such as reflection, glare and shadow, when
positioning your screen.

Unit release 1 (Aspire Version 1.1)
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Workstation features

The features of an ergonomic workstation are highlighted in the diagram below. Some
features of the workstation may vary depending on the type of computer work being
performed. Graphic work may require the use of a pen tool, and multiple monitors are
commonly used for a variety of digital work.

Top of screen

Centre of screen

Bottom of screen

Top line of sight
Bottom line of sight
Head

Shoulder

Elbow

Above knee

Below knee

Footrest

Back of chair

Under chair

Chair legs

The screen angle should be adjustable between 85 and 125
degrees to the horizontal.

Minimise screen reflection and glare by using an anti-glare filter.

Place a document holder beneath or beside the screen at the
same viewing distance as the screen.

The viewing distance should be between 400 mm and 700 mm.
A relaxed viewing angle is approximately 35 degrees.

Keep your head erect.

Have your upper arms hanging freely.

Have your forearms approximately horizontal.

Ensure there is clearance between the lower edge of the desk and
your legs.

Ensure there is clearance between the front edge of the seat and
the lower leg.

Use a footrest if needed.

The back support should be adjusted to support the small of your
back.

Adjust the seat height to suit your furniture and equipment.

Use a chair with a five castor base.

8
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Desktop layout
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Items on your desk, including equipment and resources, should be arranged within
easy reach.

Your desk area can be divided into three zones:

o the optimum reach zone - the area closest to you, where your hands operate most of
the time

o the maximum reach zone - further away, but still close enough to reach comfortably
« the outer reach zone — where you may have to bend forward or stand to reach items.

Make sure your desk is organised so that frequently used objects, such as your keyboard,
are close to you. Intermittently used objects, such as your phone, should be out of the way
but still within easy reach. Other resources used less frequently, such as in- and out-trays,
should be in the outer reach zone.

Adjust your equipment and posture

When your posture is poor, you may suffer from aches and pains. Spending a long time in
the same position can put stress on your body and this can be made worse if you are in an
uncomfortable or poorly supported position. These symptoms may start out very slight, but
if you continue to use poor posture they may get worse and become intolerable. They may
result in cumulative stress given the constant stress on your muscles, nerves or tendons.
When setting up your workstation, you need to make sure your posture will not cause you
pain or discomfort. The equipment you use needs to be adjusted to suit your body shape and
size, and the tasks you are doing.

You have already looked at adjusting your screen and chair. There are other office tools that
can help your posture. These include the following items.

Unit release 1 (Aspire Version 1.1)
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Document holders

Document holders are designed to
hold papers and reference material in
a convenient position for viewing. Place
your document holder in the correct
position. If it is below the screen or too
far off to the side, each time your eyes
look from one source to the other, your
pupils have to adjust. Doing this for long
periods of time can cause headaches
and eyestrain. Place the document
holder at a similar level, angle and
distance as the screen to avoid having
to shift eye focus.

Footrests

A footrest may be necessary if you can’t
place your feet comfortably on the floor.
Footrests allow your feet to rest at the
correct height and on a tilting angle,
which prevents strain on the lower
back.

Home office

Angle boards

Angle boards allow the user to maintain
correct posture when reading, by
reducing the angle between the work
surface and the vertical posture.
Adjustable to a suitable height

and angle, these supports enable
comfortable reading with the neck
correctly positioned. Try to keep your
neck as straight as possible when you
are reading.

Headsets

If you use a telephone for long periods
of time, itis a good idea to use a
headset. A headset will keep your neck
straight and your arms free. Headsets
prevent you from bending your neck to
support the telephone handpiece.

Communication technology and organisational policies to maintain a sustainable work-life
balance are creating opportunities for more flexible working arrangements. This means that
more employees are working from home offices or in other remote office locations. Many
benefits can be derived from flexible working arrangement for employers and employees,
but there is still a responsibility for all parties to make sure that home and remote offices use
ergonomic practices and follow WHS requirements.

Hot desking

Hot desking is an office organisation system that is used in some workplaces where
workstations are not assigned to an individual worker. Workstations may be used by
multiple workers during different time periods or shifts.

The motivation behind hot desking is primarily the cost savings achieved by setting up
fewer workstations in workplaces where not all the workers are in the office at the same
time, or not in the office for long periods at a time.

Another common adaptation of hot desking is where work stations are assigned to
individual workers, but need to be readily available for other workers to access based on
daily work requirements, such as a group of people coming together to work on a

specific project.

10
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WHS and workplace culture considerations with hot desking

¢ [tis common for workers to want their own space. Consequently, they may tend to

choose one location and stick to it.

¢ |t can take extra time each day to set up a work station for ergonomic and work

efficiency.

¢ Personal hygiene needs to be maintained to prevent the spread of germs on keyboards

and desk surfaces.

* Workstations need to be tidied appropriately in readiness for the next user. This can

also involve some cleaning.

Standing desks

Sitting at a desk for long periods of time has many
negative health impacts. It is claimed that the negative
effects of prolonged sitting cannot be counteracted by
regular exercise and that the only way to eliminate this
problem is to avoid sitting as much as possible.

These negative health impacts can be overcome through
the use of standing desks. Standing provides a greater
opportunity for your body to move and adjust and
involves more muscular activity than sitting.

Some of the health benefits from standing include:

"%‘

« alleviating back pain and other repetitive stress

injuries by greater use of core back muscles to support the upper body

» increasing focus, alertness and activity level by releasing restless energy

 reducing the risk of developing cardiovascular disease, diabetes and blood clots, which

can be caused by prolonged sitting.

Standing desk ergonomics

Using a standing desk for hours on end requires you to adapt. It is recommended that you
start using a standing desk gradually by alternating between sitting and standing. You may
experience sore feet, tired legs and fatigue at first. Wear comfortable shoes and use an anti-

fatigue floor mat.

An ergonomically designed standing work desk means you can maintain correct posture

while working.

Position arms at 90 degrees when typing/standing.

Place the computer screen at eye-level and tilting it slightly upwards.

Place the computer monitor at least an arm’s length away.

Avoid leaning over the desk; keep your body straight.

Unit release 1 (Aspire Version 1.1)
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Monitor environmental factors

Environmental issues in the workplace include lighting, noise control and air quality. If
the environment of your workplace is not monitored and controlled, you may suffer from
headaches, fatigue, hearing loss or eyestrain.

Light

Good lighting is essential for a safe and hazard-free workplace. You need to see things
clearly to work effectively. Simply shifting the screen slightly, adjusting blinds, altering the
brightness settings on the screen and using desk lamps can avoid many light hazards. Try
to use natural sunlight if the office layout can accommodate this. If not, keep bulbs and
fixtures clean, focus light on your task and use fluorescent lights if possible.

Improper lighting can cause eyestrain and headaches.

Hazards associated with lighting include:
o glare — a computer screen positioned in front of a bright window can be difficult to see

o flickering lights — a fluorescent light may malfunction, causing annoyance, irritation
and nausea

« inadequate or dim light - reading in dim light causes eyestrain
« reflections - sunlight reflecting on a screen can make it difficult to read

o shadows - shadows shifting across your work area can cause you to sit with bad posture
in order to read your work.

Noise

Noise can include any annoying or disturbing sound. Excessive noise around heavy
machinery or equipment can cause permanent hearing loss. Noise is a problem if it disturbs
people, distracts them, interferes with communication, causes people stress or generally
interferes with their work.

Many offices are open-plan in design, often with employees seated close to each other and
divided by partitions at chest or head height. Think about noise levels when you set up your
workstation. It should be possible for people in open-plan offices to have some privacy when
they are on the telephone and carrying out their day-to-day activities.

Noise in the office can come from:

« machines (photocopiers, fax machines, printers)

« other equipment (telephones, paging systems, music)

« background noise (lifts, air-conditioning, traffic)
« people talking.

Noise management

Noise can also be a problem outside office environments, such
as on factory floors, at construction sites or near airports. You
may have to wear ear protection if you are required to work in
excessively noisy areas.

There are many ways that problem noise can be controlled in the workplace. Noisy machines
can be put in a separate room or area. Sound-absorbent materials such as carpet and
partitions can be installed or arranged to deflect and absorb noise. The volume level on your
telephone’s speaker can be adjusted.

12
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Remember that noise is only a hazard when it is stopping you from working productively,
comfortably and safely. Many people prefer to work with low levels of noise rather than
complete silence.

Air
Air-conditioned offices do not have fresh air from open windows. This can cause problems
for some people.

Office workers frequently complain of being too hot or too cold. If a person’s desk is near an
air-conditioning outlet, the area around their desk can be much colder than elsewhere in
the office. They can also suffer from dry and itchy eyes. Report such hazards to the relevant
person. This situation can usually be corrected by adjusting air-conditioning flow.

Organise your work

Having a well-planned workstation and comfortable surroundings is pointless if you don’t
organise your work in a way that prevents discomfort or pain. Make sure you plan your
daily tasks so that you aren’t doing repetitive work for long periods of time. Make sure you
take rest breaks and exercise regularly.

Positive work organisation includes:

o amixture of repetitive and other activities
o rest periods

o exercise breaks.

Vary your activities

Your work role may involve several different tasks. Some tasks may be repetitive, such as
typing up reports or entering data. If you are able to vary the tasks you carry out each

day, this will help prevent repetitive actions that cause stress to your body. For example,

if you have to enter a lot of data, break up the repetitive nature of the task by discussing a
project with a fellow worker, collecting some research from the internet or doing another
constructive workplace task you are responsible for. Workflow should be designed to reduce
the repetitive tasks given to particular people.

Take rest periods

All employers need to provide rest periods for employees. Rest periods include tea breaks
and lunch breaks. During the working day everyone needs to sit down, breathe easily, relax
and take time to think about something other than work.

Have exercise breaks

When working with a computer, you should have short breaks at regular

intervals to combat stress and prevent pain and discomfort. As discussed E.F:_':'-E
previously, using computers for too long without breaks has been associated M'gé’#
with back and neck pain, headaches, migraines and eyestrain. ;,':_5 L
Try the following exercises several times a day, and encourage others around E Y b
you to try them. Make sure you are relaxed and stretch gently, without

overstretching. Stop if you feel any pain or discomfort, and remember to @
exercise both sides of your body. Most importantly, breathe deeply and evenly

throughout the stretch.
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Neck

Shoulders

Wrists, hands and arms

Turn your head gently to look over your right
shoulder. Hold for 10 seconds. Now roll your
head forward to look over your left shoulder
and hold for 10 seconds. Repeat several times.

_

Sitting with a straight back and neck, roll your
shoulders forward, then back. Repeat several
times.

L

Interlacing fingers, turn palms upwards. Now
lift arms over your head and stretch, leaning
gently to the left and then to the right. Repeat
movement several times.

Upper and lower back

\_

In a standing position place hands in the small
of the back. Gently arch back and hold for 10
seconds. Repeat when needed.

Shoulders and arms

Eyes

L

Stretch your arms above your head, cradle
your elbow with your hand and gently pull your
elbow behind your head. Repeat on the other
side, holding the stretch for 10 seconds.

Every 20 minutes, look away from the screen.
Focus on a distant object (more than three
metres away).

N N N N N
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Work without stress

Here are some tips for working without stress.

Tips to help minimise stress

¢ Adjust your chair and desk to suit your body.

¢ Position your screen to suit your posture.

¢ Adjust other equipment for safe and comfortable use.
* Reduce excess noise.

* Ensure you have adequate light.

* Arrange your desktop so you can access things easily.
* Take regular breaks from your work.

¢ Frequently rest your eyes.

¢ Do stretching exercises.

e Vary your tasks.
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Practice task 1

1. Here is a checklist to follow when setting up your workstation. Go through the points that are
relevant to you and make any necessary adjustments to your work or study space. You may
need another person to help you and check your posture. If you are not able to tick some of the
checkpoints, change your study space or discuss making alterations to your workstation with your
manager.

Chair

Q Is the seat height-adjustable?

Q Isit high enough to allow you to sit comfortably over the keyboard?

Is it stable?

Does it swivel?

Is the height of the backrest adjustable and does it tilt backwards and forwards?
If it has arms, can you still get close enough to the desk and swivel the chair?
Are your feet flat on the floor, or are you using a footrest?

O0000DO

Are you sitting up straight with the backrest firm against your back?

Desk

Q Isitlarge enough to allow the screen and keyboard to be correctly positioned?
a Isitlow enough to allow you to keep your forearms horizontal or sloping downwards?
Q Is it high enough to allow your thighs to fit underneath it?

Keyboard

Q Can it be tilted to allow you to adjust it?
Q Are the symbols on the keys clear and easy to see?
Q s there sufficient space in front of it to allow you to correctly position your arms?

Screen

Q Does the screen have easily adjustable brightness and contrast controls?
a Is the image on the screen stable and flicker-free?

Q Are there adjustment mechanisms to allow the screen to be tilted, swivelled or raised to avoid
glare and reflections and help you keep a natural and relaxed posture?

Q Are you sitting far away enough from it for comfort?

continued ...
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... continued

2. Describe the possible consequences for an organisation in which employees do not consider
their physical health.

3. What should a WHS policy include?

4. What should WHS procedures include?

5. Why should you vary the tasks you carry out each day?

Unit release 1 (Aspire Version 1.1)
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Minimise wastage

Practise conservation techniques

Conserving resources at work benefits not only the
organisation by reducing costs, but also the planet by
reducing greenhouse gases and the amount of waste sent to
landfill. Most organisations have policies and procedures
for conserving resources. You can find out what these are by
reading your workplace manual or asking your manager or
colleagues.

Ways to conserve resources at work include:

minimising paper wastage

reducing energy use.

Minimise paper wastage

Wasting paper costs organisations and the planet a great deal. Consequently, many
organisations have developed policies for paper usage. These include:

using both sides of the paper when photocopying

recycling non-confidential waste paper in recycling bins

storing email messages in an electronic folder instead of printing

reducing the volume of printing where possible

reusing paper by using blank sides for rough drafts and reusing folders and files
using recycled paper or paper from plantation timber for printed documents
using a recycling service to collect waste paper.

18
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Using the following statistics, consider how many trees are used for office paper.

How many trees are used to produce paper?

The statistics in this example are based on US short
tons (2,000 pounds), not metric tonnes.

Source: www.conservatree.com

One ton of uncoated virgin (non-recycled) printing and office paper uses 24 trees.
One ton of 100 per cent virgin (non-recycled) newsprint uses 12 trees.

One ream (500 sheets) of paper uses six per cent of a tree.

One tree makes 16.67 reams of copy paper, or 8,335 sheets.

One carton (10 reams) of 100 per cent virgin copier paper uses 60 per cent of a
tree.

One ton of coated, non-recycled higher-end
magazine paper (used for high quality photographic
magazines) uses more than 15 trees.

One ton of coated, non-recycled lower-end magazine

paper (used for news magazines and most
catalogues) uses nearly eight trees.

Minimise energy use

Wasting energy also costs organisations and the planet a great deal. Many organisations
have developed policies and procedures to save energy. These include:

o providing training programs on smart energy practices so that employees can practise
energy efficiency

 turning off equipment when not in use

« using power-save functions for equipment

« refilling toner and ink cartridges from printers.

Resource conservation

Here are some tips for practising conservation.

Resource conservation tips

* Use the power-save function on printers when they are not in
use.

* Print and copy on both sides of the page, where possible.

¢ Use recycled paper (paper used on one side) in the
photocopier and printer for rough drafts.

¢ Use recycled paper for telephone messages.
* Place a recycling bin near the photocopier.

Unit release 1 (Aspire Version 1.1)
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Practice task 2

Look at the following statements and decide whether you think they are true or false.
1. Screen savers save energy.

2. Turning off computers crashes the hard drive.
3. Refilled toner or ink cartridges leak everywhere and make an incredible mess.
4. Putting computers into sleep mode when they are inactive saves energy.

5. Printing and filing all documents in hard copy does not put a high demand on resource
consumption.

Unit release 1 (Aspire Version 1.1)

20 © Aspire Training & Consulting



Topic1
Prepare to use spreadsheets

Nearly every organisation today uses computers,
hence it is highly likely your work will require you to
be familiar with several computer applications,
including programs for creating spreadsheets.
Organisations use spreadsheets to store and calculate
numerical data, which can then be used to produce
such things as charts, graphs, statements and reports.

Many organisations have specific requirements about
how data is stored and the way it is displayed and
presented. You must be aware of these requirements
so your spreadsheet meets your organisation’s
standards. These requirements can relate to how the
data is entered, stored, presented and produced.

You also need to know the electronic filing system for storing spreadsheets. This is a normal
part of using any computer application and it is part of workplace protocol. It is important
to ensure you store your spreadsheet for easy access by yourself and your colleagues.

Microsoft Excel is a very common spreadsheet application. The examples in this learner
guide are based on Excel 2013. Earlier versions will be similar in how they work, although
there may be some differences in the appearance of the screens.
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Spreadsheet layout
Before you start entering data you should be familiar with the layout of a spreadsheet.

A spreadsheet is a grid of columns and rows. It has numbers down the side and capital
letters across the top. There are other items located above and below the grid. You will use
these in every spreadsheet you create so it is important you understand what they are and
how to use them. The items include:

o Spreadsheet work area
o Title bar

« Ribbon

¢ The Formula Bar

o The active sheet

Spreadsheet work area

A spreadsheet is called a worksheet. Multiple
spreadsheets are called a workbook. A spreadsheet

is divided into columns and rows. The intersection
of each column and row is called a cell. The current
cell is shown by a highlighted rectangle. This is the
cell that data can be entered into. To move to another
cell, click into the required cell. Each cell has a name.
The name is simply the letter above the cell and

the number to its left. The cell name is called a cell
reference, like a grid reference on a map.

22
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Title bar

The title bar holds the name of the workbook. It has the standard minimise, restore and
close functions of most applications.

Ribbon

Common commands are organised into a series of tabs in what is referred to as the Ribbon.
The File tab helps users find features related to document handling such as saving, sharing,
protecting, printing and sending a document.

Protect Warkbook Froperses

ral

Inspect WOt book

FOVE DIOIATERL MATOT ) I W D00 PO

Versions
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For each tab, there are groupings of tools; for example, under the Home tab the
groupings are:

o Clipboard

« Font

o Alignment

o Number

o Styles
e Cells
« Editing
[\
o ora WAW Ew AT :
e, B e it N oA = ¥ By P oy =2 X ] :'\' &
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You need to familiarise yourself with the various tools available in Excel 2013. The most
common tabs used are Home, Insert, Page Layout and View.

To learn about the various tools, rest your mouse pointer on the button. A help bubble
appears that briefly describes the purpose of the tool.
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The formula bar

The formula bar displays the current cell reference you are working in. As you become more
experienced with spreadsheets, you will use the formula bar to make calculations.

Ho o=
FILE HOME INSERT PAGE LAYOUT FORMULAS DATA RE
A S T a - —_—
B ?’C“‘ Calibri -n ca s =E=E %-
@ Copy ~ )
Paste v | :REE e Ay . | Wl (=
- ¥ Format Painter ru == Y- A e | B
Clipboard 7] Font P Aliy
P30 v i fe
A B C D E F G
1 4
2 ]

The active worksheet

The active worksheet information is located in the bottom left-hand corner of the
spreadsheet. By default, each new workbook contains three blank worksheets. It is possible
to add or delete worksheets.

w

~

w o w w w
[&)]

1w
|\© 00

Sheetl | Sheet2 Sheet3 (-i-)

If you wish to rename your active worksheet:
o double-click on the relevant sheet tab Sheetl] | sheetz | sheet3

o type in the new name. Yeucly Solus Dote | Shrcld | Ehot 7
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Enter data into a worksheet

Spreadsheets have been designed to enable you to
enter two main types of data — numbers and text. =4 30 ¢
Later on we will also see how to enter formulas. = \;:?00200 =
Examples of the types of data that may be s i §
entered into a worksheet include sales figures, o005 57 3, 80p $80 |
sales projections, market share, budget figures, m $73 oo =
questionnaire results or text information. Regardless *G00 _El\ $80 o
of the type of data entered, it will need to be % 3800 S
formatted in a meaningful and useful way. When o \5/:3“‘ 80,00,
formatting data to create a report or presentation, it W05 —=6 ‘-9800 55
is important to ensure that the end product is clear ~ === }}Z\QQ 9.000
and easy to use. \:\\\00 Se

80, Onn

Most organisations will have set standards for the

way they want spreadsheets produced, including font, font size, worksheet names and colour
use. When producing spreadsheets you should seek advice and clarify requirements from
supervisors and colleagues to ensure you are complying with organisational standards

and designs.

The following example shows how to enter information into a spreadsheet. The data you will be
checking represents the monthly income and expenses of Amy’s Booksellers for a year.

A B C D E
1
2 Amy's Booksellers
4 |Month Income Expenses Profit Clear Profit
5 |January 5332 1232
6 February 5322 1231
7 |March 6433 435
8 |April 5432 2123
9 |May 2424 522
10 June 2341 233
11 uly 6322 234
12 |August 7234 242
13 September 5223 452
14 |October 4223 234
15 |November 9642 522
16 December 10462 432
17
18 ‘Totals 70390 7892

1. Open Microsoft Excel 2013.

2. Click into cell C2 and enter the text Amy’s Booksellers.
3. Click into cell A4 and enter the text Month.

4. Click into cell B4 and enter text Income.

continued ...
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... continued

5. Repeat this process across the row and enter the text Expenses, Profit and Clear Profit into their
own cells (see illustration to guide you).

Click into cell A5 and enter text January. 4

7. You can enter the names for the rest of the months in two ways. 5 |January g
Type each month into its own cell as shown or you can use the Fill 6
function.

8. To use Fill, move the cursor over the little square in the bottom right-hand corner of the cell with
January in it. The cursor will form the shape of a small black cross.

9. While pressing the left mouse button, drag the small black
cross (Fill handle) down. You will begin to see the names of
other months appearing. Keep dragging until you reach the
cell that says December.

January

10. Release the button and Excel will automatically fill in the oty

months for you.

W~ o s

5 |January

6 |February
7 |March

8 |April

9 |May

10 {June

11 [July

12 |August

13 |September
14 |October
15 |November
16 |December

11. Enter the values as displayed in the example under the relevant headings Income and Expenses.

12. Save your worksheet in a suitable location on your hard drive and name it Amy’s Booksellers.

L 5

Amy's Booksellers

v

1 Month Income IE'.Dcnw-. lr‘vohl l(lc.u Profit I
S January MR 1232
February s3R 1231
7 Merch 6433 435
g April $432 nn
9 Moy 2424 22
10 June 2341 233
11 July LY prd 234
2 August 7234 42
15 Septembet 223 a5
14 October 4223 234
15 November 9642 S22
& December 10462 432
13 Totals 03N 7892

13. Select one of the numbers you have entered in the Income column. Click into the cell and re-type
the new number.

14. Save your changes and close your worksheet.

Unit release 1 (Aspire Version 1.1)
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Make changes to data

At some stage you will need to alter the data you have entered into a spreadsheet. You may
have typed it in wrongly or you may have new, more up-to-date figures to use.

The following example shows one way to make changes to data.
1. Click into the cell where the change is required.

[Month Income Expenses
Janvary | 5332 1232
{February 5322 1231
2. Re-type the data as required.
'Month Income Expenses
January 4556 1232

3. Click outside the cell. The changes have been made.
4. Save the worksheet to save the changes.

Select multiple cells, columns or rows

You will often need to select more than one cell at a time. The following information
outlines several techniques for selecting areas of a spreadsheet.

5 |January 4556 1232 Select a group of cells by dragging the mouse
6 F~eb‘ruéryr 5322: 1231 Click on the first cell in the range you want
7 |March 6433 435 to select. Hold down the left mouse button
8 |April ‘ 5432 2123 and drag over the required cells. To select a
9 |May ' 2424 522 single cell, click into the cell. Selected cells are
10 [June | 2341 233 highlighted.
11 July 6322 234
5 |January 4556 1232 Select a row
6 February 5322 1231 Click on the row number button. This will
7 |March 6433 435 highlight the whole row.
g April 5432 2123
9 May 2424 522
A B C Select a column
1 |Month Income Expenses Click on the column letter button. This will
2 |January 4556 1232 highlight the whole column.
3 |February 5322 1231
4 |March 6433 435
5 |April 5432 2123
6 |May 2424 522
7 |June 2341 233
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Select the entire worksheet

O A 8 4 Click on the cell in the top left-hand corner
1 |Month Income Expenses of the worksheet to the left of column A.
2 |January 4556 1232 Alternatively, on the keyboard press Ctrl+A
3 February 5322 1231 together. This will select the whole worksheet.
4 |March 6433 435
5 April 5432 2123
6 |May 2424 522
7 |June 2341 233
8 |July 6322 234
5 |January 4556 1232 Select multiple ranges
6 |February 5322 1231 Select cells using any of the above methods and
7 |March 6433 435 then hold down the Ctrl key while selecting the
8 |april [ 5432’ 2123 second (or more) range of cells.
9 |May _ 2424 522
10 [June 2341 233
11 [July 6322 234

August 7234 242

12
13 |j 5223 452

Presentation

You want your spreadsheets to be clear and easy to understand and to conform to any
requirements of your organisation. Many organisations use templates to make it easy to
produce standard layouts. The templates may already have standard worksheet formatting
such as shading, font formatting, headers and footers, logos, column and row headings and
predefined formulas.

You may just have to enter the data or alter only parts of the layout. A consistent layout for
documents boosts the image and reputation of the business.

You may be given guidelines or specific instructions on how to produce spreadsheets for
particular purposes. If you are, it’s important to follow them. Clarify instructions if needed
and ask questions if you are not sure what to do. If you have your own ideas about how the
content or format of a document could be improved, speak to your supervisor.

Storage

Where you store your spreadsheet depends on who needs the information. When you create
a spreadsheet you need to save it immediately. You can save it to your personal hard drive or
to a shared drive on your organisation’s server. A server is a computer, linked by a network
to other computers, which stores information so other people can use it.

Ask your manager where you should save your spreadsheet so it can be used by whoever
might need it.

28
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Folders are a good way to store common documents — as long as you have a meaningful
naming system for them. Computer folders are similar to those in a manual filing cabinet.
To retrieve a document, you need to know which filing cabinet and drawer, and which folder
or index it is stored in. Folders should have meaningful names such as product numbers

- PN134, client numbers — Smith3422, and project titles - Newtech Project. The naming

of spreadsheets is also important for future retrieval. The names need to be meaningful.
Examples of meaningful spreadsheet names include 2010-QTRI1 Sales Report, Smith3422
Jan 10 Client Report. Using names such as Spreadsheetl or Sales Reportl does not make it
easy later on when you need to find a particular spreadsheet.

File compatibility

In Microsoft Excel 2013, when a spreadsheet is saved it has the file extension .xIsx. Previous
versions of Excel have the file extension .xIs. The file extension tells the computer system
what type of file it is and what program to use with
that file.

If you are creating a spreadsheet that needs to be
used by people with an older version of Excel, you
will need to save the file in compatibility mode. To
create a spreadsheet in compatibility mode, select
the File tab, select Save As, and select Excel 97-2003
Workbook in the Save as type list.

Ensure you have selected an appropriate drive and
folder for saving; then in the file name box type a
meaningful name for your spreadsheet, and click
Save. You should do this when you start creating a
new spreadsheet.

Output

When you start a new spreadsheet, you should think about how you want the spreadsheet to
present the results, or output, of its calculations.

Some points about output to keep in mind include:

« Who is going to use the results?

o What are the results that will be useful to them?

o How are they going to use them?

o What format will they want them in?

«  What labels should you put on any number results so people can understand what
they are?

« Is the output going to be printed, stored or sent to someone electronically?
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Practice task 3

Read the case study, then answer the questions that follow.

Josh works as an administrative assistant in a large organisation. One of his duties is to create
spreadsheets to his manager’s specifications. One day Josh is asked to create a spreadsheet
containing the monthly sales figures of a selection of products the organisation sells. The
spreadsheet has to calculate the total takings for each product and then work out a 10 per cent
taxation charge for each amount calculated.

The spreadsheet must be formatted to organisational requirements and then saved to the
server in the shared folder for sales. Josh’s manager tells him to name the spreadsheet Product
Totals.

As well as entering the monthly sales figures in one column, Josh has to create two more
columns of information.

1. Describe the information to be held in the two new columns.
2. Decide on names for the two new columns.

3. How does Josh have to format the data?

4. What is the name of the spreadsheet and where will it be stored?

continued ...
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... continued

Read the case study, then answer the questions that follow.

Case study

Phuong works as an administrative officer for a local council. She has recently moved into the
community development department from the rates department and is looking forward to the
change. Phuong has been asked by her supervisor to create a spreadsheet report summarising
the number and type of small businesses in the area, and to include a chart that shows the
clustered locations of the businesses. Phuong is familiar with using spreadsheets and creating
charts from her time in the rates department. Phuong is not sure how to go about finding out
the information to include in the report - does it mean that she has to go out and visit all the
small businesses?

Phuong decides to speak with her supervisor to clarify what is required to produce the report.
Phuong’s supervisor explains that it is a report which is completed on an annual basis, so she
should be able to access last year’s report from the network drive in the folder 2014-Small
Business. However, her supervisor is not sure of the spreadsheet name so she will need to have
a look for it. Her supervisor suggests that she follows the same layout and presentation as last
year’s report, although she should check that it has the current council logo in the heading.
Phuong asks her supervisor who the report is for to check output requirements. Her supervisor
explains it is to be presented at the upcoming managers’ meeting next Friday. Her supervisor
has asked that she complete a draft of the spreadsheet by Wednesday morning so that he can
check the report. Once checked, 15 copies of the report need to be produced.

Phuong goes back to her desk and locates last year’s report. She now knows how it is to look.
She also knows her deadline, the reason for the production of the report and how many copies
are required. What Phuong doesn’t know is where to get the current data for entry into the
spreadsheet. She goes back to her supervisor to check. The data is contained in another report
that was produced by her co-worker last month. That report contains information about all

the types of businesses in the area (small, medium, large), as well as projections of potential
businesses in the area. Her supervisor tells her to see Ingrid to check the file location and
name. Phuong speaks to Ingrid to get the location of the report. Phuong is now able to use this
report as her source document for creating the report that she has been asked to complete.

continued ...
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... continued

5. What is Phuong'’s task?

6. What does Phuong do to clarify task requirements?

7. What additional sources of information were helpful to Phuong in producing the report?

Summary

1. Make sure your workstation and working conditions are safe and healthy so you can
work comfortably and productively.

2. Organise your work area and your working day to ensure that you enhance and promote
a healthy and safe work environment.

3. Practise conservation techniques to try to minimise paper wastage and energy use.

4. 'When producing a spreadsheet, check requirements for data entry, presentation, output
methods and quantity. This ensures the final product meets organisational and task standards.

5. Store spreadsheets in locations that can be accessed by those who need to use them in
the future. Ensure that spreadsheet names are meaningful so you can easily locate the
information at a later date.
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Learning checkpoint 1

Prepare to use spreadsheets

This learning checkpoint allows you to review your skills and knowledge in preparing to use
spreadsheets.

Part A

All staff have been asked to submit their ideas on promoting a healthy and safe work
environment within the workplace.

1.

Write your ideas on how you or your colleagues could improve work practices in
terms of:

workstation design and layout
using adjustable, ergonomic equipment
ensuring good posture and work habits

identifying and reporting potential workplace hazards and risks

saving energy and other resources.
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Part B

Read the case study, then answer the questions that follow.

Case study

Selda has recently started work as a marketing assistant with a large car sales business. She
has been asked to create a draft summary report of all existing customers, the types of cars
they have purchased and if they are repeat customers. The information is to come from the
product sales database. This information will be used to select customers for the marketing
campaign for the newly released family wagon. The report will be used by five members of the
marketing team and seven sales managers. The marketing manager has asked to see a draft
of the spreadsheet by the end of the week. The spreadsheet is to be stored on the server in the
product folder PNwagonXXRO0O07.

Selda knows she needs to abide by organisational requirements for the design and layout.

1. Explain how Selda would identify the following:

The purpose of the spreadsheet

The audience for the spreadsheet

The data source used for data entry

The information to be reported in the spreadsheet
The number of copies of the spreadsheet required
Where to store the spreadsheet

How to name the spreadsheet

34
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2. State four possible organisational requirements that Selda needs to consider when
preparing the spreadsheet.

3. How would Selda be able to find out the presentation requirements for the spreadsheet?
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Designing a spreadsheet means knowing exactly what you need to do, and how to do it,
before you start building the spreadsheet. This planning helps make sure that you don’t
waste time producing a spreadsheet that doesn’t work properly, is hard to use or doesn’t give
the information that people need.

You may be able to use predefined spreadsheets and automatic functions to save time and
to make sure your spreadsheets comply with the standards of your organisation. They make
the task of creating and formatting a spreadsheet easier — saving time and reducing errors.
In this topic you will learn how to:

2A  Design a spreadsheet to suit the purpose and requirements of the task

2B Design a spreadsheet that is understandable and attractive

2C  Use style sheets and automatic functions
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2 Design a spreadsheet to suit the purpose

and requirements of the task

When producing a spreadsheet you should be guided by the requirements of your
organisation. It is always important to clarify instructions so you are clear about what is
needed. If you have your own ideas about how the content or format of a spreadsheet could
be improved, speak to your supervisor.

Steps in designing a spreadsheet

Here are some points to consider when you set about designing a spreadsheet. We will look
at these steps in more detail in the following pages.

Steps in designing a spreadsheet

Appropriateness to required task
Headers and footers

Analysis

Headings

Formulas

Restricting access to parts of the spreadsheet
Functions

Importing and exporting data
Charts

Macros

Formatting

Multi-page documents

Appropriateness to required task

Spreadsheets are used to analyse figures and present them in a way that is easy for people to
understand. Always ensure the spreadsheet does what is needed.

It should be easy for people to put data into the spreadsheet, as well as to understand what
comes out of it.

There are five main things you need to know before you start planning, or designing, your
spreadsheet:

o The purpose of the spreadsheet

o Who will use the spreadsheet

o The type of information that needs to go into the spreadsheet (the inputs)

o The information that the spreadsheet needs to produce (the outputs)

o What the spreadsheet has to do with the inputs in order to produce the outputs (the
processing)
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Analysis

Some typical ways a spreadsheet can make analysis of
data quick and easy are:

o calculating the average of some numbers

o calculating the totals of lists of numbers

« working out percentages

o calculating simple and compound interest using
formulas.

You need to know how to get the spreadsheet to do :
these things by putting formulas and functions into e e sy
cells in a way it can process. )

Excel uses formulas and functions (built-in formulas)
to manipulate numbers so you can analyse them in
whatever way you need.

Formulas

You can enter a formula into any cell. To do this you must start with an = sign, so the
spreadsheet knows that it is a formula and not something else.

The most basic operations a formula can do are:

o add using the symbol +

« subtract using the symbol -

« multiply using the symbol *

 divide using the symbol /

Enter a formula

If you want to add two numbers, follow these steps:
1. Enter one number into a cell, say Al.

2. Enter the other number into a cell, say A2.

3. Type a formula into another cell. For this example, type =A1+A2 into cell A3. (If the = is
not present, Excel will not recognise the entry as a formula, rather it will assume that it
is simply a text entry.)

4. When the formula is typed, press Enter. The answer to the calculation will be displayed
in cell A3.

The formula takes the numbers stored in cells A1 and A2 and adds them. The answer is put
in the same cell where you entered the formula.

If new numbers are typed in Al and A2, notice that cell A3 now displays the new answer
automatically when Enter or an arrow key is pressed. You don’t have to type the formula
all over again. It simply stays there, processes the data from Al and A2 and records the
result in A3.

This is what using spreadsheets is all about. You don’t have to repeat the same calculations
over and over each time you get new data, as long as you use the cell references of the cells
containing the data that your formulas and functions will use and not the actual numbers in
the cells.
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Functions

A function is a formula that is built into the spreadsheet. Functions can save a lot of effort
by doing quite complex calculations in one cell. Excel provides functions to do a variety of
common calculations, such as SUM or AVERAGE. For example, =SUM(B5:B17) adds all
the numbers in the range of cells from B5 to B17. Functions can be used in Excel to perform
a variety of mathematical, statistical and financial calculations to help you to analyse
information. Some common functions used in Excel, with examples, are shown in the
following.

=SUM(range)

Adds the numbers in the cells that are within the range specified in the
brackets.

Example: provides a total of all assessments the student has completed.
=SUM(B5:Eb)

=MAX(range)

Finds the highest value from cells that are within the range specified in the
brackets.

Example: shows the highest student result from the group.
=MAX(F5:F7)

=MIN(range)

Finds the lowest value from cells that are within the range specified in the
brackets.

Example: shows the lowest student result from the group.
=MIN(F5:F7)

=AVERAGE(range)

Finds the average of numbers in the cells that are within the range specified in
the brackets.

Example: shows the average result of all students.
=AVERAGE(F5:F7)

=COUNT(range)

Counts the number of items in the range.
Example: counts the number of results entered for the class.
=COUNT(F5:F7)
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Charts

Charts are a good way to show the results of the
spreadsheet analysis because they can be grasped
quickly, without the user having to do too much
thinking; for example, a ‘pie chart’ or a ‘bar chart’
would be good to show what percentage of total
sales each of several models of cars contributes. To
show how the temperature in a coolroom varies over
several weeks, a ‘line chart’ or ‘scatter chart’ would
be best. By using charts, you save people the trouble
of having to look at lots of figures.

Format

Formatting a spreadsheet means to present the information in the most understandable
way. You can do things like highlight important text and numbers using bold or italic, or
underlining or shading. The choices are very similar to those available in word processing
programs. You can also adjust the column width or row height and adjust the alignment
of the text — centre, right, left or angle. You can choose how numbers are presented; for
instance, in currency format, as decimals with a particular number of decimal places, or in
date format.

Headers and footers

Headers and footers are used to record common information in the margin of the report.
The header is at the top of the page, the footer is at the bottom. Headers and footers are
automatically repeated onto all pages of the spreadsheet report. Headers and footers might
include the company name and logo, name of report, creation date of report and file
reference information.

Headings

Headings in a spreadsheet are the letters above the columns and Gridlinis
the numbers beside the rows. These headings are useful because
they give you an understanding of where you are located within
the spreadsheet. Some people prefer to work without the headings Print Print

displayed. Headings can be turned on and off by selecting the Page Sheet Options 1
Layout tab and checking or unchecking the Headings View box.

Headings

V| View V| View

You can also choose whether to print headings.

Displaying or printing headings is useful when you are checking that information has been
accurately entered, particularly when checking for errors with formulas or functions.
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Restrict access to parts of the spreadsheet

It is possible to limit the sort of data, and the range
of data, that can be entered into a spreadsheet; for
instance, only putting numbers in and not letters.
An unprotected spreadsheet has many places where
someone could enter data in the wrong place, or " .
change a formula and ruin the spreadsheet. You can
put restrictions on what parts of the spreadsheet
people can change.

Import and export data

You may want to bring data into your spreadsheet
from another application such as Microsoft Access.

This is called importing data. The following tools,
located in the Data tab under the Get External Data grouping, are used to import data.

B [y [h oy Iy
!_@ ‘_@a B L$ =
From From From From Other Existing
Access Web Text Sources* Connections
Get External Data

You would need to import data if the information you require is stored in a customer
database. You may need to import customers’ contact details, for example.

Exporting Excel data to another application from Excel can be done by copying and pasting
the required information. You might need to do this if the data needs to be analysed or
presented in a different way.

Macros

Macros make it easy to do common tasks; for example, if you regularly insert the company
logo into your spreadsheet, instead of going through all the steps to insert the logo, you

can design a macro with a short-cut keyboard command. Then all you have to do is use the
keyboard command and your logo is automatically inserted. Macros can also be assigned to
graphics within an Excel spreadsheet.

Multi-page documents

If the report from your spreadsheet is longer than one page, you need to ensure you have
designed the spreadsheet so the information can be understood regardless of which page
your audience is reading.
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Practice task 4

Read the case study, then answer the questions that follow.

Helen has recently taken up a position as an administrative officer with a government
department. Her manager has asked her to compile a spreadsheet report analysing the number
of people who have travelled overseas in the past year, as well as information on countries
visited. She has also been asked to ensure that she follows standard guidelines for producing
the report such as colours, font type and size and the department logo. The report from the
spreadsheet is to be distributed to media outlets. A graphical representation showing the top-
10 locations for travel is also required.

1. Who is the audience for the spreadsheet?
2. What is the purpose of the spreadsheet?

3. What are the information requirements?

4. What are the elements of spreadsheet design that Helen needs to consider?
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2 Design a spreadsheet that is

understandable and attractive

The spreadsheet should clearly highlight key information by using titles for columns and
rows, and formatting such as shading, borders and font style.

Important information, such as the results, should not get lost among other things (such as
the data that has been entered).

Numbers and text should be aligned within cells in the way that is easiest to read.

E‘)'(‘*;

FILE HOME INSERT PAGE LAYOUT FORM

i, dbcut Calibri - A
bacse B Copy =
S ¥ Format Painter B oL W | enex - 'A'

Clipboard P Font
c17 Y| I

A B C

1 {123.56 123.56 123.56
2 §167.89 167.89 167.89
3 ﬁ567.98 567.98 567.98
4 1354.98 354.98 354.98
5 1365.98 365.98 365.98
6 |98.23 98.23 98.23.
7 |67.54 67.54 67.54
8 432.76 432.76 432.76
9 Left justified Centred Right justified

Spreadsheet styles and layouts
The layout and presentation of the spreadsheet

should project your organisation’s image. Many
organisations use spreadsheet templates to help
maintain a standard appearance. These may have
font formatting, headers and footers, logos, formulas
and functions, and the title text of the spreadsheet
already there. It may just be a case of entering names,
addresses or summary figures, or altering only parts
of the content. For example, if you are required to
produce a monthly report of financial information,
the only difference each month will be the financial
data. The formulas and overall appearance will be
the same. Your organisation may have a template set

up with all the required row and column titles and
shading, font type and size and so on, and you will
only need to input the required figures.
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Improve presentation

In Microsoft Excel 2013, there is an option to apply cell styles to the spreadsheet. These are
predefined styles available for your use. Styles relate to font type, font formatting, number
formatting, borders and shading. It is as simple as selecting the cells that require the style
applied, choosing the Home tab, and selecting the Cell Styles button. From here you can
choose to apply a predefined style or create a new style for future use.

You might choose to use different predefined styles for row and column titles, the data
contained in the spreadsheet and summary information. The use of styles will add to the
appearance and overall presentation of the information.

The following example shows how style choices can be used to improve presentation. The
spreadsheet titles are formatted, and merged and centred across the length of the data. Titles
are formatted appropriately and end stock figures are shaded to highlight the end result.

Manny's Hardware Shop

June Stock Report
Stock at start

of month  Stock out Stock in  End stock
Hammer 1433 234 123 1322
Axe | 2342 1234 1232 2340
Spanner _ 2334 2111 2342 2565
Angle-grinder 3465 2341 1231 2355
.Sgrgw-q[’_iygr A 2231 1321 1235 2145
Drill | 2342 1231 1231 2342
Nail-gun 1311 1231 1324 1494
Chisel 2521 2345 1444 1620
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Practice task 5

Consider and compare these two spreadsheet examples.

Stock at

start of
week  Stock out Stock in  End stock
Apple 1433 234. 123 1322
Agric_o_t 2342 1234_ 1232 2340]
Banana 2334 2111 2342 2565
Gr'ag’ e 3465 2341 1231 2355
Kiwi fruit 2231 1321, 1235 2145
Orange 2342 1231 1231 2342
Peach 1311 1231» 1324 1494
Pear 2521 2345 1444 1620|

Good Fruit Company
Weekly Stock Report @ 30 June

4 Stock at start of week v Stock out  Stockin 'End stock
Apple 1433 234 123 1322
Apricot 2342 1234 1232 2340
Banana 2334 2111 2342 2565
Grape 3465 2341 1231 2355
Kiwi fruit 2231 1321 1235 12145
Orange 2342 1231 1231 2342
Peach 1311 1231 1324 1454
Pear 2521 2345 1444 1620
continued ...
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... continued

1. What are the differences between the two examples?

2. Which one is easier to read? Why?
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2C Use style sheets and automatic functions

A style sheet is similar to a template and is used to apply predefined information,
formatting, formulas and functions to a spreadsheet. Style sheets can be protected to ensure
that users cannot change anything apart from the information they are required to enter.

Several automatic functions may also be used for designing spreadsheets. Automatic
functions make it easy to create a spreadsheet that is professional and easy to read.

Style sheets and automatic functions are useful tools for ensuring that spreadsheets
produced by different people in an organisation are consistent in their appearance.

This is especially important if your spreadsheet is going to appear with others in the same
document or presentation. This consistency improves your professional image and that of
the organisation as a whole. For example, a covering letter that accompanies a report should
be consistent in appearance with the report itself. The following example illustrates a word
processing document and a spreadsheet with a consistent appearance.

0

I.T. ISUS Sn Davidson
Consultant Sales Report #’:‘g’;.gwm

Month = January

Mary $ 652.00 ——
Alistair S 1,234.00 MONTHLY PERFORMANCE RESULTS
Fred $ 1,243.00 | e pleased to provide you with a copy of the summary report of consullant
Taylah $ 2341.00 sales rasuls for the month of January
Gl A3 of our consultants a7e oehveving thei targets. and &5 uch are entied 1o

Gerry S 5,235.00 the monthly bonus of $500. It woukt be appreciated if you would take the
Gowry $ 5 435.00 opproprate action fo ensure thot this i Inccrporated into the next oey cycle,
Jim S 6,346.00 Regarcs
Total S 22,486.00

Henry Jonnson

Salos Manager
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Style sheets

A style sheet is a predefined spreadsheet that is used as a template. A template can be

accessed by selecting New from the File tab.

You can create a template from a blank spreadsheet. A template allows you to create a
structure for other spreadsheets using common data and formatting options.

1. To do this, firstly create the spreadsheet component or structure you want to use.

2. Select the File tab and select Save As.

3. Give the template an appropriate name, and in the ‘Save as type’ option choose ‘Excel

Template’.

If you are working in Excel 2013 and the template is to be used by people who have a
different version of Excel, you need to choose the option Excel 97-2003 template.

File name: lBookl

S_ave.astype:‘ Excel Workbook

L

_ |Excel Workbook
Authors: |Fxcel Macro-Enabled Workbook
Excel Binary Workbook

Excel 87-2003 Workbook

XML Data

Single File Web Page

Web Page

Excel Template

Excel Macro-Enabled Template

D
Text (Tab delimited)
Unicode Text
XML Spreadsheet 2003
Microsoft Excel 5.0/95 Workbook
CSV (Comma delimited)
Formatted Text (Space delimited)
Text (Macintosh)
Text (MS-DOS)
CsV (Macintosh)
CSV (MS-DOS)
DIF (Data Interchange Format)
SYLK (Symbolic Link)
Excel Add-In
Excel 97-2003 Add-In
PDF
XPS Document
Strict Open XML Spreadsheet
OpenDocument Spreadsheet
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Borders

Borders are lines applied around a cell or cells. Borders are used to keep certain information
separate from other parts of the spreadsheet or to highlight the information.

1. To add a border, select the area where you want the border to apply.

2. From the Ribbon choose the Home tab and select the appropriate Border tool from the
selection list.

_, ﬁ)-A' =

, Borders ;

Iff

il

€<= 3

Bottom Border
Top Border
Left Border
Right Border

No Border
All Borders

Qutside Borders

B EH

Thick Box Border

Bottom Double Border

Thick Bottom Border

Top and Bottom Border

Top and Thick Bottom Border

Top and Double Bottom Border

Draw Borders

¥ Draw Border

E;" Draw Border Grnid

& Erase Border

L—_’ Line Color »
Line Style b

FH More Borders...

Unit release 1 (Aspire Version 1.1)

30 © Aspire Training & Consulting



Topic 2
Design a spreadsheet

Headers, footers and page numbers

Headers and footers are used to incorporate information into the margin of a spreadsheet.
Examples include current date and time, file reference, and page numbers.

To insert a header or footer, from the Insert tab, select Header & Footer. You will now be
able to enter the required information or use the tool buttons to design your header or
footer. After entering a header or footer, the on-screen view is Page Layout. To return to the
normal view, select the View tab, and select Normal.

Page numbering is commonly used in either the header or footer of the spreadsheet to show
the number of pages of a spreadsheet, as well as the current page that you are viewing in
the printed version. To insert page numbers, select Header & Footer from the Insert tab.
The Design tab will appear, then you can select the appropriate page numbering tool as
shown below.

ﬂ- H ¢ HEADER & FOOTER TOOLS

ove s

AYOUT FORMIALAS DATA REVIEW VIEW ACROBAT DESIGN

PAGEL
—_—
7

Different Odd & Even Pages Ahgn with Page Maegins

header example]

If you are showing both current page number and total number of pages, then you need to
manually type in ‘of” as this is not automated.

Alignment

Text and values align differently within the cell by default. Text aligns to the left, values to
the right. To adjust the horizontal alignment of data within a cell, select the cell or cells and

choose the appropriate alignment tool from the Home tab. = = =

Horizontal alignment options include left, centred or right.

Alignment of data within a cell can also be adjusted for the height of the cell. The automatic
default is to align the text to the bottom of the cell. To adjust the vertical alignment of data
within a cell, simply select the cell or cells and choose the appropriate alignment tool from
the Home tab. Data can be aligned to the top, centre or bottom of the cell. Text can also be
oriented to be on an angle. . %o/‘
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Merge & Center tool

Another common tool used to align cells is Merge & Center. This is commonly used to align
a heading across the width of data in the spreadsheet. Look at the following example:

A B C D E F G
1 Henry Lewis Consulting & Co
2 Sales results
4 Sales Consultant
5 |Month Hannah Joe Fredrick Simon Carolyn Nim

6 |January 12334 12324 5334 45434 2421 1232
7 February 34543 23466 5456 12334 1243 1245

In this example, the headings Henry Lewis Consulting & Co and Sales results have been
merged and centred across the columns A:G. To perform this action, each row is dealt with
separately.

First, the data from cells A1:Gl are selected and then the Merge & Center tool
ElMegeacenter - on the Home tab is pressed. Next, the data from cells A2:G2 are selected,
and then the Merge & Center tool is selected. This provides the data with a heading.

Extra space can also be added to the spreadsheet by adjusting the column width and row
height. This can be done by positioning the cursor between either the letters of the columns
to be widened, or the numbers of the rows to be made taller. A double-headed arrow will
appear that will enable you to click and drag to adjust the column width or row height.

When using Merge & Center, the data to be merged across the cells must be in the first cell
selected.

Typeface styles and point size

Many organisations have standard requirements for font type and size. To adjust the font
type and size, select the cell to be changed and make your selection using the Font tool and
Font Size tool as shown below.

Arial 12 ¥

Automatic functions
Excel 2013 provides a number of automatic functions to quickly perform common tasks.

Some functions to preform common tasks include:
o Date & Time

o AutoText

o Proofing

o Default settings

» AutoCorrect

o Styles

o Table headings
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Date & Time

To automatically insert the current date into a cell,
select the cell and press ctrl+;

To insert the time, press ctrl+shift+;

To automatically put the current date in a cell within
the worksheet, you can use the TODAY function:

=TODAY()

Being an automated entry, it should be noted that as
the date changes, this will be automatically updated
to the current date.

Proofing

Proofing automates the proofreading process so common errors or entries are easier to
detect. The Proofing feature can be customised by clicking the File tab, choosing Options
and selecting Proofing.

T x|

ABC! .
"{ € hange how Excel carrects and formats your teat

®

Frashing Autolorrect oplom

iye Change how Excel cortects and formats 1ot a3 you type | futeCormec Option.. l

New Lengusge
When correcting speling in Microsoft Office programs

' ignore woeds in UPFERCASE

' 1gnoce weeds that contain numpere
Quick Accent Tockhat F lgncec Internet and file sddresses
Save A4 Im ¥ Hlag pepeated words
et Coctie IT Inforce accented uppescase in French
Save As ™ Sugges from main dictionary enly

Quisom Dictionases I
Save as Adobe French modes: ITud(mll and new \pnlmgt‘:’
PDF Spanish modes [Ymeo verb forms only :]
Dvetronary language: |fn9lnh {(Auntzehe) ;’

Open Customize Ribbon

Print

Share

Export

Close

Account

Options
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AutoCorrect

AutoCorrect automatically corrects common
typing errors; for instance, if you were typing the
word ‘what’, and accidently typed in ‘whta’, Excel
will correct the error to ‘what’. In most cases, you
don’t even notice you have made the typing error.

It is a handy feature, but only works for common
words. You can customise the list of words you want
AutoCorrect to fix.

AutoText

AutoText is a facility that completes text as you type.
Excel recognises that you may have entered the same
information previously. For instance, you may be
typing in locations of retail outlets, such as Sydney,

Melbourne and Adelaide. Once you have typed in these entries, when you type the data for
the next entry, Excel will automatically provide an option for you to select from rather than

retyping. Look at the example below:

Location:
Adelaide
Melbourne

Sydne
|Melbour’ne

In this example, notice that when Melbourne is being typed again, as soon as ‘M’ is typed, it
automatically completes the text. It is then only necessary for you to press enter to accept it.
If it is another entry that you are completing — such as Malvern - just continue typing.

Default settings

Default settings are the original settings of the
spreadsheet. People sometimes refer to the default settings
as cell entries with no style applied; however, it is a style
called Normal. This style has preset formatting such as
font type=Arial, font size=12. There is no other formatting
applied to the Normal style. To adjust data to the Normal
style, select cells to be adjusted, and from the Home tab,
go to the Styles group, click on Cell Styles, then select
Normal | e

Default settings also relate to column width. The standard
width of the column is 8.43 characters. If you have
adjusted the column width and want to return to the
default setting, select the column you want to adjust, and
from the Home tab, go to the Cells grouping. A drop-
down menu under the Format icon will allow you to
adjust the width to the default.

gm %x iﬁ > AutoSum - éY
= (¥ Fill -
Insert Delete Format % Sort &
22 = e & Clear~ Filter
Cells | Cell Size

IC Row Height...
AutoFit Row Height
U1 Column Width...

AutoFit Column Width

Default Width..,
Visibility
Hide & Unhide »

Organize Sheets
Rename Sheet
Move or Copy Sheet...
Tab Color 4
Protection
7 Protect Sheet...
Lock Cell

E Format Cells...
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Styles

In Microsoft Excel 2013, it is possible to use styles to format individual or groups of cells.
To do this, select the cells to be formatted by clicking and dragging to highlight them. To
format using styles, from the Home tab go to the Styles group, then select Cell Styles and

click on your choice.

P 115y Good Dad and Neutrad
7 853
. 5

Normal Bad Good Neutra

Condtional Fotmat at

Formatting * Table ™ | g1y and Moded

icukation Chek €l :!luml | Note
Output warning Taxt
N | Tithes and Heodings
Heading 1 Heading2  Heading3 Heading 4 Title Total

Themed Call Stybed
20% - Accontl 200 - Accent? 205 - Accent3  20% . Accentd 209 - Accents 20% - Accentt
40% - Accent]l  40% - Accent2  40%- Accentd  40% - Accentd  40% - AccentS  40% - Accentt

A .+ Avodpts |
it o xinin s

Kumber Format
Comma Comma [0] Currency Currency [0] Percent

Styles apply formatting such as colour, borders, font type and size to the cell.

Table headings

In Excel 2013, it is possible to convert your data into a table. Tables make the information
easy to work with, as formatting is automatically applied and it is possible to have the titles
of the table automatically become headings. This can be useful for sorting and reviewing
data. The following example demonstrates how data has been converted to a table format

with headings.

MAXIMILLIAN FURNITURE SUPPLIES
PRODUCT LIST FORECAST

Melboume M Adelaide ¥

\Oak Table 'Oak Bench |Country Table
[King Chair 'Country Table King Chair
Oak Bench . 0Oak Sideboard , Country Chair |

The table headings have arrows that enable you to quickly sort the data.

To convert data to a table, select the cells by clicking and dragging to highlight them, and
then from the Insert tab, select Table.
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Practice task 6

1. Create the following spreadsheet and save it as a template named Monthly Consultant Sales
Report.

Consultant Sales Report
Month=

Andrew
Gary
George
Lisa
Mary
Taylor

Practice using the template. Select the File tab, choose New, and select My Templates. The
Monthly Consultant Sales Report template should be available for your use, as below.

New

Y Home » Custom Office Templates
Open

Save

Save As

Save as Adobe
PDF

Print

Share

Export

Monthly Consultant Sal...

Close

Account

Options

Here are some of the features you can incorporate into your style sheets:
* Dborders

* page numbers

e alignment

* typeface styles and point size.

continued ...
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... continued

2. Create the following spreadsheet and apply borders as shown - thin inside borders for key
information, and a thick outline border for the entire report. Save the file to an appropriate file
location and name it August Car Sales.

Beautie's Used Cars
Car sales - August

~ Car Make & Model - .

Sales Person |Ford Falcon |Mazda 6 Holden Astra |Honda Accord|Nissan Patrol |Kia Rio

Gilbert 45 11 63 25 5 6
Harry 11 34 11 6 52 5
Ingrid 12 24 1 62 11 21
Jon 32 65 11 2 1 4
Mark 11 & 34 5 52 41
Selda 6 52 52 1 5 4
Vishna 2 5 5 11 52 52

From the Insert tab, select the Header & Footer. Insert the current date and current time into the
footer. This will now be part of the spreadsheet.

Adjust the column width and row height to give more space. Adjust the alignment within cells to
improve the presentation of the data. Start by centring vertically and horizontally.

3. Using the following information, create a spreadsheet that meets the following requirements:
Font - Arial 14, bold and italic
Titles - shade background in yellow

Border - thick outline

The information is to be used by the financial analyst at a meeting to discuss profit levels. Save
the file to an appropriate location and name it Fashion Excess - stock on hand.

Stock item Quantity on hand Cost per item Retail price per item
Knickerbockers 188 $45 $86
Flower power pants 191 $55 $92
Flare pants 192 $51 $98
Skirts 101 $18 $67
A-line skirts 76 $23 $87
Hot pants 177 $34 $76

continued ...
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... continued

4. Practise using AutoText with the following spreadsheet entries.

SOCIAL CLUB RAFFLE WINNERS
1st prize Mary Johansen
2nd prize Helga Smithe
3rd prize Gilbert Goshwig
4th prize Mary Johansen
5th prize Mary Johansen
6th prize Mary Sinclaire
Tth prize Gilbert Goshwig
8th prize Gilly Green
9th prize Helga Smithe
10th prize Helen Wilson

Save the file in an appropriate location with the name Name list. Practise applying different

styles to the data.

5. Create the following spreadsheet, and convert it to a table with headings. Practise using the
heading arrows to sort and review the entries.

Favourite Animals

Cat Giraffe Hamster Lion
Dog Dolphin Rabbit Zebra
Frog ,Dog JFish ,Hippo g
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Summary

1. Spreadsheets are used to analyse data and present the results in a clear and
understandable way.

2. When designing a spreadsheet you need to know its purpose, who will use it and the
inputs, processing and outputs required.

3. The design of the spreadsheet should meet the needs of the person requesting it, as well
as organisational expectations and standards.

4. You can use formatting, charts and other graphics to improve the readability and overall
presentation of the spreadsheet.

5. Formulas and functions simplify the processing of data.

6. Automatic features can be used to save time and reduce errors.
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Learning checkpoint 2

Design a spreadsheet

This learning checkpoint allows you to review your skills and knowledge in designing a
spreadsheet.

Part A

Workplace learners can either complete this assessment using a spreadsheet that they
produce in the workplace or use the following scenario to complete the assessment.

Read the scenario, then complete the tasks that follow.

Imagine you are working as an administrative officer for Eastern Employment Agency. The marketing
manager asks you to create a spreadsheet to be used as a summary report to promote their
achievements in work placements. Information is to be presented to show weekly results as well as
monthly achievements of the past quarter. The weekly information for the report is as follows:

7 January 5038 123 1231 402 829
14 January ? 234 1234 341 893
21 January ? 12 435 123 312
28 January ? 43 1121 455 666
5 February ? 341 341 23 318
12 February ? 121 234 28 206
19 February ? 12 432 231 201
26 February ? 42 123 53 70
5 March ? 411 532 43 489
12 March ? 123 522 234 288
19 March ? 12 100 50 50
26 March ? 234 123 12 111

To comply with your organisation’s requirements you must:

insert a header stating the name of the business

insert a footer that displays the current date and time

insert a background shading - light blue

use a thick outline border, and a thinner line for inside borders
use bold titles

use font type - Arial

use font size - 14pt
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1.

3.

Create a report of the weekly results. You need to have the spreadsheet calculate the
client numbers at the start of each week.

Use appropriate cell references to complete the calculation.

Calculate as follows:

o Client numbers at start of week = number at start of previous week + number of new
clients - number of clients placed in work.

Create a monthly summary report as requested by the marketing manager. Use the
SUM function to calculate summary figures for each month.

Save the file to an appropriate location and name it Work placement summary.

Part B

Read the case study, then complete the tasks that follow.

Case study

Mara works as an employment coordinator for Eastern Employment Agency. She has been
asked to produce a monthly summary report for the operations manager to present at the next
management meeting. The report is to show the number of paid-work industry placements. The
information will be used to analyse market segments. The total figures for each segment should
be presented as a pie chart. To comply with the organisation’s requirements Mara must:

insert a header stating the name of the business

insert a footer that displays the current date and time

insert a background shading - light blue

use a thick outline border, and a thinner line for inside borders
use bold titles

use font type - Arial

use font size - 14pt

Mara produced the following spreadsheet for the operations manager.

paid industry placements

MONTHLY RESULTS
TOTAL
Number of
paid

Month RETAIL TRADE CLERICAL TECHNOLOGY placements
JANUARY 1234 231 234 1001 2700
FEBRUARY 502 12 23 258 795
MARCH 345 123 125 345 938
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1. What is the purpose of the spreadsheet?

2. Who is the spreadsheet for?

3. What are the task or information requirements for the spreadsheet?

4. What are the organisational requirements for the spreadsheet?

5. Has Mara produced a spreadsheet that conforms to the organisational and task
requirements?
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What could Mara do to improve the overall readability and appearance of the
spreadsheet?

How would the use of a style sheet have helped Mara?

Produce the spreadsheet yourself. Note you will need to use the SUM function to total
industry segments — use these figures to produce the chart. Save the spreadsheet to an
appropriate location. Name it Summary industry paid placements.

What automatic functions did you use in producing the report?
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Previously you have learned how to design, or plan, a spreadsheet. It is important to know
the purpose of the spreadsheet, who will use it, the inputs and outputs, and the processing
needed to analyse the inputs and produce the outputs. It is also necessary to check your
work to ensure it is accurate, and overcome any design flaws that may have arisen in the
process of creating your spreadsheet.

In this topic you will learn how to:

3A  Enter, check and amend data

3B Format a spreadsheet

3C Use and test formulas and functions

3D Overcome problems with spreadsheet design and production
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3 A Enter, check and amend data

Several types of data go into a spreadsheet. Once the
data is in the spreadsheet, you need to check that it is
correct, and fix any mistakes. Remember the
acronym GIGO, which means ‘garbage in, garbage
out’. If you put the wrong data in, you get the wrong
answers out.

The different types of spreadsheet data include:
o dates and times
o text

o numbers.

Examples of text data are names, addresses and
product information. Date and time data can be in
numerical or text format and can include months,
days, hours, minutes and seconds. Examples of numbers are quantities, customer numbers,
pricing, sales figures and interest rates.

Excel treats data differently, depending on whether it is text, number or date/time.

Dates and times

Dates can be entered in the following formats:
o Day/Month/Year = dd/mm/yyyy
o Month/Day/Year = mm/dd/yyyy

For instance, 12/03/2012 is the 12 March 2012 if the format is Day, Month, Year but it is 3
December 2012 if the format is Month, Day, Year.

Times can be am and pm or 24 hour. Ten past six in the afternoon is 6.10 pm or 1810 hours.

Excel 2013 tries to match the formatting with the way the information is
typed in. 19-May-15
2/07/2015

Always confirm the correct formats for your spreadsheet.

Text

A B
When entering text, you will notice it is automatically aligned to 1 lIngrid Heffernan |
the left of the cell. You will also notice that if there is no data in the
adjacent cell, the text will overflow into it. 3
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View text in the Formula Bar

If there is data in the adjacent cell, the text that is entered will be
truncated (chopped off).

A B C

1 |Ingrid Hef Morris Green

~

It may appear that the data is lost, but it is still contained in
the cell.

A simple way to confirm this is as follows:

1. Click in the relevant cell. Al ¥ fe || Ingrid Heffernan

2. View the cell’s contents in the Formula A 8 ¢ D E

Bar. 1 Ilngrid Hef_lMorris Green

Format the cell to wrap text

To ensure the printed and on-screen versions of the A B

spreadsheet show the cell’s full content, you need to adjust the 1 !ngrid Heffernan Morris Green
R

width of the cell or wrap the text within the cell. =

Text is commonly used for entries of lists of information such
as names, addresses, product details, and other descriptive information.

To wrap text in a cell:
1. Select the cells.
2. Use the Wrap Text tool E¢wrpTet , which is located on the Home tab.

Wrap Text is commonly used for longer entries where you don’t want to adjust the column
width but want to be able to read all of the information in the cell; for example, address
details.

Adjusting cell width is explained in the next section on numbers.

Numbers

When entering numbers, the alignment is to the right of the cell. In most A
cases, if the number is longer than the cell, the width of the cell will 1 123
automatically adjust. The number of digits for a value is limited to 15.

Sometimes numbers appear as shown below. This occurs
when the number has too many digits for Excel to deal with,
so it rounds it off and puts it in scientific notation.

A B
1 | 1.24E+12 Tom Evans

When the cell is not wide enough for a number entry, it is 2-3ul-15
filled with a row of hashtags (#). This is a different situation to having too
.. i
many digits.
To correct the problem, adjust the cell width.
General v

Use the Number grouping to increase or decrease the number E ..
. . . v OF o R
of decimal places shown. It is also possible to make number $-% * %%

formatting choices such as currency. P—— -
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Adjust cell width

The easiest way to adjust the cell width is to position your cursor - .
between the column headings and drag the cursor to the point +

where you want the width of the cell to end.

Alternatively, you can AutoFit the cell width to the longest entry by double-clicking between
the column headings.

Check spreadsheets

It is important to always check your spreadsheet for accuracy. This may include double-
checking with your colleagues or manager to make sure the data you have entered is correct.
As well as checking the values you have entered, you should also ensure that any labels are
spelt correctly and that you have formatted all data to suit organisational requirements.
Spreadsheet checks to carry out include:

o theaccuracy of data entered

« that formulas are working correctly

o that all instructions have been followed

« the consistency of design and layout.

Check the accuracy of data entered

If the information contained in the spreadsheet is not accurate it will cause problems for
others and reflect poorly on the company you represent. For example, you might mistype
the figures in a summary of house sale prices. Taking the time to check information and
making sure it is correct helps to save time, improve office efficiency and increase the
prospects of customer and organisational satisfaction.

To check errors in labels, select Spelling under the Review tab. This identifies misspelt
words. It cannot assist with product names, customers’ names or addresses. Manually check
your spelling and crosscheck it with the documentation you used to enter the data. For
example, you may have been given a printout of all customers’ names to be entered. Once
you have entered the customers’ names, check them for accuracy against the printout.

You should check all information, including:

« name and address details

o spelling

o product information and pricing

« dates

« reference details; for example, catalogues and previous correspondence.
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Check formulas are working correctly

When using formulas and functions, always make
sure the result you get is the result you want. Test
formulas and functions before using them in the
spreadsheet. Do this using a calculator. Also check
the consistency of information against the original
data and check that cell references, operators and
functions are correct.

You may be able to give the information you produce
to a colleague or supervisor to check in draft form
before you complete the final version.

Use the Show Formulas tool ¥ Show Formulas  on the
Formulas tab to review formula entries.

Check all instructions have been followed

Producing spreadsheets requires you to follow instructions. Instructions may be given

by your manager or supervisor, the person requesting the spreadsheet, past spreadsheets

or instruction manuals. Instructions may relate to the spreadsheet’s content or its format
and layout. For example, you may be asked to produce a sales report summarising weekly
figures, and provide a comparison of actual figures with target figures. You may be required
to identify sales personnel and specify their performance in terms of actual and target
performance. These instructions provide guidance on what is required for the report and
how it is to be produced.

If instructions are not followed, it may delay the final production of the report, or reduce the
usefulness, meaning and credibility of the information. If you need to clarify instructions,
or have your own ideas about how the spreadsheet could be improved, speak to your
manager or the person requiring the information.

Ensure consistency of design and layout

Always check the design and layout of your spreadsheet conforms to your organisation’s
standards. Consistency in design and layout makes a spreadsheet easier to read, ensures it is
useful and meaningful and promotes the image of your organisation.
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Practice task 7

Here is a spreadsheet and the original information used to create it.

Customer accounts worksheet

A B C D

1 Custoemr Accounints

2

3 Customers Balance 10% Interest New Balance
4 Smithe $5,500.00 $550.00 $6,050.00
5 Cartter $4,000.00 $400.00  $4,400.00
6 Andrew $3,450.00 $345.00 $3,450.00
7 Philips $300.00 $30.00 $300.00
8 Elliott $2,500.00 $250.00 $2,750.00
9 Frank $500.00 $50.00 $550.00
10 Luiee $34.00 $3.40 $37.40

Customer documentation

Smith 55.00

Carter 4,000.00
Andrews 3,455.00
Phillips 3,000.00
Elliot 2,500.00
Franks 5,000.00
Luie 34.00

1. How many errors are in the worksheet?

2. What are the consequences of numeric values being entered incorrectly?

3. What should customer Smith’s balance be?

continued ...
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... continued

4. Create the worksheet with accurate information. Save it to an appropriate location, and call it
Customer Accounts.
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3 B Format a spreadsheet

There are numerous techniques for improving the appearance of spreadsheets. Here are
some examples of how formatting can change the appearance of a spreadsheet. Compare the
two examples: the first has not been formatted and the second has.

A A
1 |Profit 1 | Profit
2 123 2 123
3 234 3 234
4 768 4 768
5 675 5 875

Alignment on page

When creating spreadsheets, it is best practice to begin your spreadsheet at the start of

the spreadsheet in A1. What occurs, however, is that when you print the spreadsheet, the
information begins at the upper left of the page. This is reasonable for presentation of a
longer report but if it is a shorter report, the spreadsheet will seem to be crammed into one
corner. Look at the following example of page alignment:

4 A | 8 [ e | o | € | ¥ | 6

1| End of year STUDENT RESULTS

2 | Results (each assess = 2.5% of overall result)

L! Studentname Assess1  Assess2  Assess3  Assessd Total

4 MaryJones 23 21 19 21 84

L] Jon Youga 12 14 16 15 57

6 | Keon Rasimi 24 18 20 21 83
MINIMUM

7| RESULT 57
MAXIMUM

8 | RESULT 84
AVERAGE

L9 | RESULT 74.7

10

1

aa |
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Page alignment

To adjust the alignment so the information is centred in the page, follow these steps:

1. From the File tab, select Print, then select Page Setup at the bottom of the Settings panel
2. Select the Margins tab

3. Under Center on Page click Horizontally and Vertically

The Page Setup dialog box also provides a preview of your changes.
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Use Page Layout view

Page Layout view is used to quickly and easily make adjustments to the worksheet. Page
Layout view enables you to adjust layout and format data as appropriate. It is possible in
this view to change the orientation of pages, adjust headers and footers, and adjust margins,
column width and row height. This view includes row and column headers, and has a ruler
for measurement. Page Layout view appears on screen as follows:

1 Eastern Employment Agency

WEEKLY RESULTS

Client Number ol
Numberof | Numberof
numbers st ~ clients u

Week ending st of the New clients NI vltolunlary ) paid

s week work P i
v 3 7-Jan 30318 123 1231 402 823
6 14-jan 3930 234 1234 341 893
7 21-1an 2930 12 435 123 312
5] Z8-Jan 2507 43 1121 as5 666
9 5-Feb 1429 34l Jal 2] 318
10 12-feb 142 121 234 28 206
11 19-Feb 1316 12 432 231 201
12 26-Feb 636 42 123 53 70
13 5-Mar 815 411 532 43 439
14 12-Mar 694 123 522 234 288
15 19-Mar 295 12 100 50 50
1 26-Mar 207 234 123 12 111

2

Page

Layout Page Layout view can be accessed from the View tab on the Ribbon. Adjust margins
by positioning the cursor on the margin line in the ruler so it is a double arrow and click
and drag. The same process can be followed to adjust row height and column width. To
adjust the header or footer, simply click into the entry and make appropriate changes.
Orientation can be changed from portrait to landscape, and vice versa, by selecting the Page
Layout tab and selecting the Orientation tab.

Add and delete columns and rows

Columns and rows can be easily added or deleted from your spreadsheet.

To add a new row, from the Home tab, select Insert from the Cells grouping.
Choose Insert Sheet Rows from the pull-down menu. A new row will be inserted | Insert

above the selection. Y

To delete a row or column ,select the down arrow on Delete from the Cells :g%

grouping. Choose the appropriate option (column or row) to delete. ==
Delete
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Use shortcuts

Keyboard shortcut commands are useful for speeding up data entry and formatting
processes. It is possible to create macros to make your own keyboard shortcut commands
for common actions that you undertake, such as inserting a company logo. Many other
keyboard shortcuts are available. These are explained in Excel’s Help function *.

Some of the common keyboard shortcut commands include:

o  Ctrl+B to make selected cells bold

o Ctrl+I to make selected cells italic

o Ctrl+C to copy selected cells

o Ctrl+X to cut selected cells

o Ctrl+V to paste selected cells

o  Ctrl+F to activate the Find function

Practice task 8

Open the spreadsheet called Customer Accounts you created in Practice task 7.

¢ Go to Print to see how the spreadsheet will look when printed.

* Adjust the page alignment so it is centred on the page both vertically and horizontally.
¢ Check with Print Preview.

* Practise inserting and deleting columns and rows. Don’t save the changes you make. You can
also practise changing cell widths.

* Use the Help function to investigate keyboard shortcut commands available in Excel. Search for
Excel shortcut and function keys.

* Practise using some of the shortcut keys to change the format of the spreadsheet.
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3C Use and test formulas and functions

Formulas and functions are the heart of a
spreadsheet. They take your data and manipulate
it in various ways to give the outputs needed.

If you have created a formula in one cell, and you
want to repeat it in additional cells, it can be copied
or you can use AutoFill. AutoFill is used to repeat
sequenced information that is in alignment with
the selected cell. Use the AutoFill handle [ ]

to repeat the sequence of formulas and functions.

Functions are a type of formula that performs more
complex calculations. Perhaps the simplest of these to
understand is the SUM function, which is a complex
form of adding values from a range of cells together.

From the Home tab, the AutoSum icon 2 is within the Editing grouping. AutoSum
enables you to add values automatically using the SUM function. Select a range of values
that you want to calculate and click the AutoSum icon.

Test formulas and functions
You must ensure that your spreadsheet is working properly.

In complex spreadsheets, there might be several possible answers depending on the order in
which calculations are carried out.

You should input test data and use a calculator to work out what answers your spreadsheet
should give. For instance, if your spreadsheet is meant to give the average of five numbers
in cells Bl to B5, then make up some numbers and put them in the spreadsheet. Add up the
same numbers on a calculator, then divide by five to see if you have the same answer as the
spreadsheet. If not, you have probably made one of the mistakes in the list below.

Examples of some of the things that can go wrong with formulas:

o Typing in the wrong cell reference in a formula (such as B11 instead of B1)

« Making a mistake when typing the formula (such as having a + instead of a *)

« Not knowing what a formula is meant to do and so using the wrong formula.

76

Unit release 1 (Aspire Version 1.1)
© Aspire Training & Consulting



Topic3
Create a spreadsheet

Error alerts

Excel has many features to help you identify errors. For example, an alert will appear if there
is an inconsistency in a formula. Look at the following example:

Ny o s W

A B C D E F
Monthly stock control

Product Quantity at Balance at end
|Product code description  startof month  Quantity in Quantity out of month
|PL123 Recycled White 209 50 65 194
\PL344 Blue Ad paper 54 250 244 60
PL232 Green A4 paper 355 0 67 a8
|PL987 Yellow A4 paper 12 250 214 438

If you select the cell with the alert, a help bubble will appear that explains the error that

Excel has identified.
b +| 48|
o
14 48

The formula in this cell differs from the formulas in this area of the spreadsheet.

This alerts you about a possible problem.

If you find there is no error in the formula indicated in the warning message, you can
choose to ignore the error. This will remove the green error flag from the spreadsheet.
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Audit tools

From the Ribbon, choose the Formulas tab. Go to Formula Auditing for tools that
investigate errors and determine what action needs to be taken to correct them.

#ioTrace Precedents (%] Show Formulas r-’
DTI‘Z Trace Dependents Y4 Error Checking ~ i‘:, =
Watch

v ’ 5
1. Remove Arrows  ~ (/) Evaluate Formula  \wWindow

Formula Auditing

Of particular use is the Show Formulas tool, which changes the view so you can see all the
formulas in the spreadsheet.

Another useful feature is the Trace Precedents tool, which shows a diagram of where the
data in the calculations comes from. To use this tool, you firstly need to select the cell that
contains the error and then select Trace Precedents. The spreadsheet will show preceding
connections, as in the following example:

IPL232 Green A4 paper 35_5,_,__,_,_-———-0—--*—’—’_' ® ;Z;' ‘ ag]
.—’___,_o_’_’— ~
PL987 Yellow Adpaper e— 12 e— 250 & 214 43

It may also be necessary to consult with colleagues, your manager or the person who has
requested the spreadsheet to confirm the results of the formula. If the results don’t appear
to be correct, take appropriate measures to check the entries. This includes checking
calculations as well as source information. If you are still in doubt, seek advice from your
manager or colleagues.

Use of absolute and relative cell addresses

The cells in an Excel spreadsheet are all relative to each other. This means that if you place a
value in one cell and then move it, the values will alter as the cell collects information from
other cells around it. For example, the totals you calculated for each of your columns may
need to be moved to another part of the spreadsheet. However, if you move the totals values
to another location, the values would alter as the cells are no longer reading information
from the cells immediately above them. This kind of reference is called a relative reference.

This can be very important if you shift a formula, because you may need to decide if the
cell references in it should stay the same (absolute references) or stay in the same relative
position (for instance, always one cell above the formula).

To make the values remain the same wherever you place them in the spreadsheet, you need
to make the reference absolute. Relative references change when you copy and move them
and absolute references don’t. To make a cell reference absolute, you need to place the $
symbol in the reference. Look at the following example.

=C5+B5 is a relative reference.

=$C$5+$B$5 is an absolute reference.
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Practice task 9

In this exercise you are going to create a formula to calculate the values for the Profit column.
1. Create a spreadsheet named Warehouse Profit using the data below.

A B C D E F
1 Harry Mulligan's Warehouse
P
i Month Income Expenses Profit Tax End Profit
4 January 5221 523
5 February 2342 231
6 March 2523 1123
7 April 2341 345
8 May 3452 653
9 June 2346 452
10 Totals

2. Create a formula to calculate the profit. You must use the cell references of the cells you want to
use in your calculations and not the actual numbers in the cells; for example, =A3+B3 would add
up the values in the cells A3 and B3.

¢ Select D4, the first empty cell under Profit. Enter the formula =B4-C4. Use the following example
to help you.

Month Income Expenses Profit
January | 5221/ 523|=84-c4) |

* Press the Enter key to perform the calculation.
* Once you have a calculation, use Fill to repeat the calculation in the remainder of the column.
¢ Your worksheet should now look like the following example.

A B C D E F
1 Harry Mulligan's Warehouse
2
3 Month Income Expenses  Profit Tax End Profit
4 January 5221 523 4698
5 February 2342 231 2111
6 March 2523 1123 1400
7 April 2341 345 1996
8 May 3452 553 2799
9 June 2346 452 1894
10 Totals

¢ The tax values need to be calculated as 10 per cent of the profit. In E4 enter the formula
=10%*D4 (this will give you 10 per cent of the value in D4).

Look at the following example to help you.

2 Month Income Expenses _Proﬁt Tax End Profit
4 |January 5221 523, 4698|=10%"°D4, |

continued ...
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... continued

e Press the Enter key to perform the calculation. Fill the calculation down the column.

* Select F4, the first empty cell under End Profit. Enter the following formula =D4-E4. This
calculation subtracts Tax from Profit, giving you an End Profit value.

Use the following example to help you.

:Month Income Expenses  Profit Tax End Profit
]January 5221 523| 4698| 469.8|=D4-£4 |

¢ Press the Enter key to perform the calculation. Fill the calculation down the column.
* Save your work.

3. Enter the following data into a new spreadsheet.

A » B | C | D

1 N January - sales commissions

2 Name Total sales % commission January commission
3 Mary $34.050 10%

4 Henry $29.881 15%

5 |Jay $9.837 10%

6 Esther $19.884 12%

7 Al $12.098 12%

¢ (Calculate the January commission. Remember to use the cell references in your formulas and
not the actual numbers (so use B3 and not 34,050 for example).

e Save the file as January sales commissions.
4. In this exercise you are going to use a function to calculate totals.

* Open your Warehouse Profit spreadsheet. You are now going to use the SUM function to add
totals for each column of your worksheet that has a numeric value. fx

* Select cell B10. From the Formulas tab select the Insert Function button | __. . You will see
the following Insert Function dialog box. Highlight SUM and click OK. Function
2lx
Search for a function:
Type a brief description of what you want to do and then | Go I
click Go
Or select a category: [ Most Recently Used a|
Select a function:
SUM(numberl.number2,..)
Adds all the numbers in a range of cells.
Help on this function ok | cancel |
continued ...
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... continued

As you have selected a cell at the end of a column full of numeric values, the SUM function is
going to add all of these values together. Number 1 shows the formula the SUM function will
use to make the calculation and the formula result is displayed at the bottom of the dialog
box. Click OK.

B10 should now hold the calculation of all Income values added together.

Select the cells C10, D10, E10 and F10 one at a time and use the SUM function to add
the values of their corresponding columns. Your worksheet should now look similar to the
following example.

éHarry Mulligan's Warehouse

;Month Income Expenses  Profit Tax End Profit

{January 5221 523 4698 470 4228
February 2342 231 2111 211 1900
{March 2523 1123 1400 140 1260
April 2341 345 1996 200 1796
|May 3452 653 2799 280 2519
{June 2346 452 1854 189 1705
| Totals 18225 3327 14898 1430 13408

Save and close your work.

5. Open the file January sales commissions.

Use AutoSum to calculate the total of the January commissions.

Use the maximum MAX function to calculate the highest commission.
Use the minimum MIN function to calculate the lowest commission.

Use the average AVERAGE function to calculate the average commission.
Save your changes.

6. Open the file January sales commissions. Practise using the Trace Precedents tool to check you
have entered the functions correctly.
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3 Overcome problems with spreadsheet

design and production

It is inevitable that problems will arise when
designing and producing spreadsheets. Fortunately,
there are many resources to help you in overcoming
them. Using the Excel Help function, training
manuals and instruction guides may be useful. You
may also need to seek further help from colleagues or
managers. If the problem is still unresolved, you may
need to seek specialist help from your organisation’s
information technology staft.

Common problems

A common problem is not following the
requirements of the job. Examples include not
conforming to organisational standards or leaving
out some inputs.

The following table shows other common problems that occur when producing
spreadsheets.

Data entry .

* Incorrect figure entry

* Non-inclusion of information

Misspelling names .

Check spelling

Proofread and check
spreadsheet data

* Adjacent cell contains data, text
appears to truncate
A B C

1 |Ingrid Hef Morris Green
2

Text flows « Text entry flows into adjacent cell Adjust column width
over or text A 5 Apply text wrap to the cell
truncates

1 Ingrid Heffernan

2

3

Text not in full

| PL234 TV

Adjust row height

view iProduct
code item Description Adjust qllgnment of cell content
43 1ncn to be aligned to the top of the
screen, cell

continued ...
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... continued

Number entry
has too many
digits

A B
1 l 1.24E+12 Tom Evans

The number of digits is limited
to 15

Date Adjust date formatting to the
formatting not 15-May-15 same format throughout
consistent 2/07/2015
Date or time Adjust column width
or a humber 2-Jul-15
displayed as fraedisisisiisd
H#Hit#
Cell alignment | product  Item Description Adjust alignment - vertical and
not consistent | code horizontal
PL234 TV 48 inch screen, remote
control
50 inch screen, remote,
PL532 TV includes DVD player
PL756 TV 50 inch screen, remote, DVD

player, includes 10 free new
release DVDs

Result of Studentname Assessl  Assess?  Assess3  Assessd  Total Check formula or function inputs
. Mary Jones 23 21 42 12 12

calculation Check data entry

does not

appear to be

correct

Result of V—WALUE' b Alert appears when a cell

calculation . . containing alphabetical content

appears with is included in a calculation;

a #VALUE! check formula or function input

alert

continued ...
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... continued

Green error -
alert

Click on the green alert - a
message will appear to explain
the possible problem
Ekﬂ;
-l walué used In the formula i of the wrong amas Sype.

Investigate error, and make
necessary corrections

Use the warning menu to make
appropriate choices

Inconsistent Formula

Copy Formula from Above
Help on this error

Ignore Error

Edit in Formula Bar

Error Checking Options...

!nveStlgaJFlon Studentname Assessl  Assess2  Assessd Total
into possible Mary Jones 2 a2 12 85

errors in
results
needed

e Use the Formula Auditing tools

to track the formula - this can
only be used if the formula has
been input using cell references
such as =A1+A2

E:ﬂ Trace Precedents @ Show Formulas
"'C‘E Trace Dependents Y4 Error Checking ~
K Remove Arrows ~ @ Evaluate Formula

Formula Auditing

Help resources you can use

Working with computer applications can be quite
complex. There may be times when you need to seek
assistance. Excel has a built-in help function, but if
you cannot find the answer there you may need to
seek the advice of an experienced Excel user.
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Manuals

Your organisation may have task- or role-specific
manuals to help you produce spreadsheets. These
manuals may provide guidance and assistance on the
types of information a spreadsheet should contain

or may specify the instructions to be followed for
formatting and designing spreadsheets. Being
familiar with the manuals used in your organisation
will save time and increase your efficiency when
producing spreadsheets.

Excel software comes with user manuals that
describe the software features and provide step-by-
step instructions for carrying out different functions.
You can find manuals in paper-based and online
formats. Look for paper-based manuals in your
organisation or in your local library.

You may have been to a training course to learn a particular computer function or a supplier
may have instructed you in the use of a piece of equipment. Training courses usually
provide a comprehensive set of instructions or notes that are worth keeping for future

reference.

Online help

You can find information about Microsoft Office applications on many different websites.
These often contain frequently asked questions and solutions to common problems. You can
also download updates, tools and any fixes Microsoft has developed for software problems.

You may find the following sites useful.

o www.support.microsoft.com — This is Microsoft’s main site for finding help to solve
problems for all Microsoft products. You can ask questions online and download files,
including service packs, drivers and patches. This site also gives you access to the
Microsoft Knowledge Base, which offers help for all aspects of problems that can be

experienced when using Office 2013.

o www.office.microsoft.com - This site provides resources for all Office applications. It has
news and announcements and useful files that you can download. If you are connected
to the internet, you can open this site by choosing Help and ensuring you are connected

to Office.com.

Tool buttons

Each time you move your mouse pointer over a tool
button and leave it there for a moment, it will display
a help tip that tells you what the button is used for.
For instance, from the Home tab, move your mouse
pointer over the Font tools. You will notice the help
tip for the Font Color tool button.

.%v

P

Font Color

Change the color of your text,

0 Tell me more

|
I[I]
1l
b

€= 3= Merg

Alignment
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Practice task 10

Read the case study, then answer the questions that follow.

Chinh works as an administrative assistant in a small manufacturing organisation. One of his
tasks is to create Excel spreadsheets for his supervisor.

When creating spreadsheets Chinh often needs to use Excel Help to answer questions about
software functionality. If he is unsure of a screen icon’s function, he presses Shift and F1 and
points to the icon with his mouse.

Recently, Chinh attended a two-day Excel training course at a local community centre. Chinh
kept the training booklet they handed out and stores it on his bookshelf. It has a handy index at
the back for quick solutions to problems. He has also photocopied pages from various manuals
he found around the office and has placed them in a Help folder on his desk.

Sometimes Chinh experiences software function problems that cannot be solved using the
Office Assistant. Chinh then uses Microsoft’s support website to find a solution, or he refers to
the paper-based material he has gathered.

1. If Chinh experiences software functionality problems, where does he go for help?

2. Describe how Chinh uses paper-based manuals for help.

3. If you experience a software problem when creating a spreadsheet, describe the steps you
should take to solve the problem.
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Summary

1. Spreadsheets should be consistent in design and layout.
2. Spreadsheet design and layout must adhere to organisational and task requirements.

3. Text, numerals, date and time, formulas and functions can be entered into a
spreadsheet.

4. TItisimportant to proofread and check spreadsheets to ensure accuracy of the end
product.

5. Formatting options provide a means to improve the readability and design of
spreadsheets.

6. Using formulas and functions for calculations is what spreadsheets are all about.

7. Formulas and functions allow repetitive calculations to be done automatically. All the
user has to do is change the data.

8. Excel has a number of ways, such as error alerts, to identify possible errors in the
worksheet.

9. There are many ways you can get help including manuals, help desks and online
support.
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Learning checkpoint 3

Create a spreadsheet

This learning checkpoint allows you to review your skills and knowledge in creating a
spreadsheet.

Part A

Create the following two spreadsheet reports. Save them to an appropriate location and
name them as shown. Use appropriate formulas and functions to create the summary
figures. Use the various software functions to assist you to produce them. Use any help
resources available to you as needed.

No.1 Bird Watch Club
Monthilty Spot Statisties
Sird spocies
tird Wosry-
Watcher  Stublve Austratiaon Utthe ed  headed Magoie Chestout — Pink-eared Spotiess  TOTAL AVERAGE  MINIMUSM  MAXIMUN
i Quall ’on?_n Dartee Cormoeant Grebe Black Swan Goose Teal Ouch Crake
m 21 26! 23] 121 3 3 1 3 7] 12
Davied 2 1) 42 22 3 pe) 42 2 1 33
L!_nh.l ﬁ ?el 41 52 4 12! 2| 1 1 12
Gormrin 2 5% 5| 1 4 4 0 5 2
e en &) 82 [y 7] of F) 21 0 ) 5
Lee 12} S1. & 2 ol 7] 4 0 2 0
Malcoim 3 o L 23 ¥ 5 ) 0 3 0|
Shart 4 (3 7, 65 12] 6| 3 2 7 2
Truds 1 23 & 2) 1 7 2 2 10 3
Youset 1 2 a S 2! 0 6 1 3 0
TOTAL
AVERAGE
MINIMSUM
MAXINUM
22 Bird watcher awards for month
Bird watcher |Targetspots |Actual spots |% of actualto |Actual over/
name for month of month target under target
23
24 |Ali 67 =C24/B24 =C24-B24
25 David 322
26 Esther 34
27 |Gowrie 98
28 Helen 322
29 Lee 52
30 |Malcolm 123
31 Shari 340
32 Trudi 213
33 Yousef 45
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After producing the spreadsheet reports, write your answers to the following questions.

1. List the software functions that you used to format the spreadsheet.

2. What did you do to check that the formula and function calculations were correct?

3. What help resources did you use to assist you to overcome problems in the design and
production of the spreadsheet?
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Part B

Read the case study. Write down or tell your trainer, your answers to the questions.

Case study

Gabby works for a market research firm as a research assistant in the product testing
department. One of their recent projects has been to undertake a focus group to analyse
and evaluate the possible launch of a new ice-cream into the marketplace. The spreadsheet
summary results should have looked the same as the following example:

Market Research
Friday, 20 February 2015

New Product Dream Icecream
Focus Group 123

Rating scale: 1=Poor 2=Average 3=Good 4=Very Good S5=Excellent
Packaging Packaging Product

Names durability appearance appearance Product taste

Gerry 4 3 5 5

Gretel 5 4 5 4

Heike 3 4 5 5

Kyle 5 4 5 5

Linda 5 4 5 4

Nigel 5 5 5 5

Vince 4 5 4 4

Vishi 2 2 2 2

Vu 3 4 4 5

Zenya 4 < 5 5

AVERAGE 4 3.9 4.5 44

Gabby was required to do the following;:
¢ enter all result data using the predefined style (template)
* use the AVERAGE function to analyse overall ratings.

Gabby was new to using Excel, and wasn’t sure how to access and use the style sheet. She was
experienced in using the SUM function, but was not sure about the AVERAGE function. Gabby
decided that she would produce a spreadsheet that contained all the relevant information

and present that to the product manager - surely that would be enough for them to determine
whether to release the product or not. Gabby’s spreadsheet looks like this:

continued ...
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1.

... continued

Market Research

Friday, 20 February 2015

DREAM ICECREAM

Names Packaging d Packaging a Product apg Product taste

Gerry
Gretel
Heike
Kyle
Linda
Nigel
Vince
Vishi
Vu
Zenya

4

E R TE R S R N O R O I O IR VS

3

S S S IR, IRV B SR SN S oY

0 B N0 B O in 0

5

LS RV R N I SR O B IR O B R

What mistakes has Gabby made in the production of the spreadsheet?

2. What should Gabby have done to proof and check the spreadsheet?

3.

she have done to check it?

If Gabby thought there was a problem with the results of the calculations, what could
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4. What should Gabby have done to find out about style and the AVERAGE function?

5. Produce the required spreadsheet for Gabby. Save it to an appropriate location and name
it New product evaluation - ice-cream.

6. What software functions did you use to format the spreadsheet?
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A chart is a graphical representation of selected worksheet information. Charts are used to
visually represent numerical data and make it easier to spot trends, highlight changes and
compare figures over a period of time.

The type of chart you use will depend on the type of data you are analysing; for example,
you might choose a pie chart to show a single set of data and a column chart to show
multiple sets.

You must format a chart in line with organisational and task requirements. Formatting a
chart improves the presentation and readability of the information.

In this topic you will learn how to:

4A  Select appropriate chart type and design

4B  Create charts

4C Modity chart type and layout
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4 A Select appropriate chart type and design

When producing charts, it is important to follow both g
organisational and task requirements. An e
organisation may have a set preference for the type of
charts it uses. For instance, it may prefer to use
column charts as opposed to line charts because it is
easier to analyse the information. An organisation
may also use certain colour codes for the
presentation of data; if this is the case, these rules
should be followed to ensure consistency of image.

Task requirements can depend on a set of
instructions and protocols in the production of
charts. You may be asked to prepare a summary
report of monthly sales as well as a chart. If this is
the case, you need to produce two documents. If the
policy is that a certain type of chart design is used for the production of various reports, you
need to do this.

If you have any suggestions for improving the readability and analysis of charts and their
associated data, discuss them with your supervisor or manager.

Chart types and their features

If you are using an Excel spreadsheet, you will be able to display your data in a chart. The
types of charts you can select include area, bar, column, pie, line and scatter.

Charts are visually appealing and make it easy to see data and recognise patterns and
trends. They make it easier to absorb information at a glance.

Example: chart

The following example shows the percentages of types of cakes sold in a bakery presented in a pie
chart. It is easier to look at the cake shop data in a chart, rather than in the columns and rows of a
worksheet.

TYPES OF CAKES SOLD

W Sponge
M Blackforest
m Cheesecake

= Carrot

Charts are linked to information contained in the selected cells. That means if the cell data is
updated (for example, the value 45 changes to 88), the chart is also updated accordingly.
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Choose and design a chart

The kind of chart you choose and its design should
reflect your organisation’s needs. In this section, you
will look at different types of charts and consider
some of their most appropriate uses.

Area chart

Area charts are used to demonstrate changes over
time. For instance, they may be used to show and
compare changes to sales over a given time. Area

charts highlight total values across a time line.

The following example shows how yearly real estate
sales figures vary for different outlets.

A | B | & | @& | & | F | 6 | W | 4 | 1 | K

1 Northcote Yarraville  GreensborouFootscray  Hamilton
2 2012 $303,002.00 $766,299.00 $736,252.00 $234,333.00 $345,222.00
3 2013 $451,909.00 $827,266.00 $627,262.00 $342,244.00 $423,234.00
4 2014 $568,218.00 $568,209.00 $743,662.00 $443,422.00 $342,344.00
5
j Chart Title
8 $2,500,000.00
9 $2,000,000.00
10
11 $1,500,000.00
12 51,000,00000 (N 2014
13 : m2013
14 $500,000.00 -
15

$0.00
16

O

17 o{@c
18 &
19

Unit release 1 (Aspire Version 1.1)
© Aspire Training & Consulting

95



BSBITU304
Produce spreadsheets

Bar chart

A bar chart displays information as a series of horizontal bars. These charts are useful for
comparing data arranged in columns or rows. Bar charts show the differences between
individual items.

The following example shows how monthly sales vary for different departments of a
retail outlet.

Department sales for quarter

Sporting  Women's Men's Children's

goods wear wear wear Cosmetics
January  $76,688.00 $45,466.00 $34,009.00 $68,087.00 $40,827.00
February $98,882.00 $45,628.00 $40,993.00 $76,529.00 $30,887.00
March $88,998.00 $34,778.00 $39,877.00 $87,652.00 $34,098.00

Department sales for quarter
Cosmetics

Children’s wear

m March

Men's wear
February

M january
Women's wear

Sporting goods

8
8

$40,000.00 $80,000.00 $120,000.00

Stacked bar chart
Use a stacked bar chart to compare the values of individual totals to a total across categories.

The following example compares monthly department sales figures, as well as the total
overall amount.

Department sales for quarter

Sporting  Women's Men's Children's

goods wear wear wear Cosmetics
January  $76,688.00 $45,466.00 $34,009.00 $68,087.00 $40,827.00
February $98,882.00 $45,628.00 $40,993.00 $76,529.00 $30,887.00
March $88,998.00 $34,778.00 $39,877.00 $87,652.00 $34,098.00

Department sales for quarter

Cosmetics ;} -
Children’s wear :: _
¥ January
Men's wear [N [ | February
B March
Women's wear \ -
I

Sporting goods |
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Column chart

A column chart has vertical columns and is useful for comparing separate types of data
from a data series.
The following example shows how rainfall data can be used in a comparison.

Rainfall in millimetres
Melbourne Sydney

January 20 70
February 40 80
March 30 20
April 120 100
May 90 70
June 40 90
Rainfall in millimetres

140

120

100

80

60

40

0

lanuary February March Aprii May June
m Rainfall in millimetres Mebourne Rainfall in millimetres Sydney
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3-D column chart

If you prefer the 3-D look for your column chart, choose 3-D when making your chart
selection.

Use a stacked column chart to compare the values of individual totals to a total across
categories.

The following example compares monthly rainfall for Melbourne and Sydney, as well as the

total overall amount.

Rainfall in millimetres

400

200
100

Melboume
Sydney

mlanuary mFebruary mMarch mApril mMay mlune

Pie chart

A pie chart shows a data series in percentage segments. It is useful for showing data as a

percentage of a whole. Pie charts are commonly used to show which products are selling or
how much market share an organisation enjoys.

The following example of a two-dimensional pie chart shows the market shares of five health
food companies.

Health First Fitness Foods Natural Organics Fruity
15 30 5 40 10

HEALTH FOOD COMPANIES

o Health First
o Fitness Foods
m Natural

m Organics

W Fruity
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3-D pie chart

If you prefer the 3-D look for your pie chart, choose 3-D when making your chart selection.

Line chart

A line chart shows the movement of values in a data series using single or multiple lines. It is
useful for showing how the values of a data series can change over a period of time.

The following example uses a line chart to show rainfall in Melbourne and Sydney.

Rainfall in

millimetres

Melbourne Sydney

January
February
March
April
May

June

20
401
30

2l
90,
40

70
80

20
<200

70
30

140
120

100

3

20

January

Rainfall in millimetres

February March April May June

e MelboOUme w=ge==Sydney
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Scatter chart

A scatter chart is used to compare and arrange data to analyse the relationships of
information. A scatter chart displays clusters and is commonly used for statistical
comparisons.

The following example uses a scatter chart to display and analyse estimated sales and
actual sales.

Monthly sales targets

Estimated Actual
Jan-12 34000 35272
Feh-12 45000 38002
Mar-12 54000 65027
Apr-12 50000 65282
May-12 48000 53839 MONTHLY SALES TARGETS

Jun-12 43000 42722
# Estimated & Actual

70000

60000

50000 < S S
40000 =

30000

20000

10000

0
DEC-11 JAN-12 FEB-12 FEB-12 MAR-12 APR-12 APR-12 MAY-12 MAY-12 JUN-12

100

Unit release 1 (Aspire Version 1.1)
© Aspire Training & Consulting



Topic 4
Produce simple charts

Practice task 11

1. Using this table of information, note what type of chart would be best for displaying the
information and why.

Percentage of actual sales for individual product
items.

Plant sales for the week:

Tree 25%
Shrub 10%
Grass 15%
Flower 20%

Ground cover  30%

Comparison of profit for individual retail outlets
compared with year.

Profit for years 1 and 2:

Outlet Year 1 Year 2

Boronia $45,900 $65,009
Maidstone $57,392 $65,328
Dingley $45,922 $57,281
Doreen $10,282 $45,829
Altona $67,292 $56,291

Comparison of workplace hazards identified in the
organisation.

Month Factory Office
Jan 17 2

Feb 15 4
Mar 15 5
Apr 12 3
May 9 2
Jun 7 2

A chart to show changes in workplace hazard
identification over a given period of time.

Month Factory Office
Jan 17 2

Feb 15 4
Mar 15 5
Apr 12 3
May 9 2
Jun 7 2

continued ...
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... continued

Read the case study, then answer the question that follows.

Case study

Juicy Fruits is a fruit supplier specialising in fruit baskets for corporate organisations. At the end
of each month, a report is compiled tallying fruit supplied. Information reported on includes
product type, number of products supplied and sales figures. Julian Ali, the business owner,

is happy with the reports but has realised that some of the supply coordinators are finding
the information cumbersome to interpret. Julian has decided that in addition to the reports,
he would like to trial preparing the information in chart form - a chart that compares the
supply data of each of the products. He believes that a graphical representation of the data
will be easier for the coordinators to decipher and compare. As the administration supervisor,
Julian has asked you to prepare an example of how the data would be presented in chart
form. Julian has asked that you use bright colours in the charts as this complements the style
and colour range of fruit types supplied by the business. He has also asked that you present
the information in column form with product supply numbers and product types identified in
the chart. It is important that there is a heading on each of the charts to clearly identify the
information that is being reviewed.

2. What are the organisational and task requirements for producing the charts?
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4 B Create charts

To create charts in your spreadsheet, the first thing

is to know what data you want to present. The second
is to know what you want to do with it — the purpose
of the chart. Then you can choose the most
appropriate type of chart to use. The data to be
presented in the chart is known as the data range.
This information may include text and numeric data.
The numeric data is what is represented in the chart
and the text relates to the series (or group) of data.

Before you start to produce charts, become familiar
with the terms used when referring to parts of

a chart.

The following information explains the meanings of

terms you need to know.

Axes

An axis is a line that labels the
information in a chart according to
the labels in the columns and rows
of your spreadsheet. Axes (the
plural of axis) provide a reference
for measurement or comparison of
the data in the chart. Most charts
have a vertical axis (known as

the Y axis) and a horizontal axis
(known as the X axis).

Data range

The data range is the selection
of values you choose from a
worksheet to place in a chart; for
example, all the numbers in one
row or one column of data.

Categories

Categories are the names that are
placed along the X axis of a chart
and are determined by the labels
in your spreadsheet.

Legend

The legend is the key used to
identify the various data series. If
you include the series labels from
your worksheet, Excel will add
these to the legend. Otherwise the
legend will display series 1, series
2 and so on.
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Produce a chart

To produce a chart, you must first enter data into a worksheet. You then need to select the
data you want to appear in the chart. Use the Insert tab and select the appropriate chart for
the data that you wish to present. A chart is linked to the worksheet it is created from, so if

you alter the data in the worksheet, the chart will be updated.

To produce the chart, choose the data that you want to present. Select the data by either
clicking and dragging over it with the mouse, or clicking on the cell to select it and then

using the Shift key and arrows on the keyboard to select the data.

The following example shows what selected data looks like.

B B C

=

S w N -

.Northcote ‘Yarraville

‘Greensborou Footscray
2012 $303,002.00 $766,299.00 $736,252.00 $234,333.00 $345,222.00
2013 $451,909.00 $827,266.00 $627,262.00 $342,244.00 $423,234.00

'Hamilton

The type of chart you choose will depend on your organisational requirements.

The following steps show how to produce a column chart.

2014 $568,218.00 $568,209.00 S$743,662.00 $443,422.00 $342,344.00.

1. Open Excel and enter the following data into a worksheet. Save the worksheet as ‘Company cars'.

vCompany Cars

‘Ford 3
'Holden
BMW
‘Audi
‘Mazda

W 00 ~N O oBwWwN

U= =N

()

:Make Melbourne Perth

w w s 00w

(=N~ V) Bl oS )

Sydney Adelaide

1

W=,

continued ...
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... continued

2. Select cells A4 to E9. This selection should cover all the labels and values. This selection has now
become your data range. Do not include any blank rows or columns in your selected cell range.

BE=- k- g |

af (A

3-D Column

A @l I
dn a5 S

|kl More Column Charts...

continued ...
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... continued

4. The chart will now display as an object in your spreadsheet.

A B _c | D | E | F | G | H | I | J | K

Company Cars

hMake Melbourne Perth Sydney Adelaide
Ford 3
Holden
BRAW
Audi
Mazda

W 0~ o U s W
Ui PN
- AT R e R X T

W W s w

[ i
N R o

Company Cars

| Audi

Ford Holden BMW Mazda

[ o S S S R S R ST
S W W~ o Ul s W
Noow B o~

n
—
[

o oS
w w N

Ll
o=

m Melboume mPerth mSydney mAdelaide

. To move the chart to a separate sheet within the workbook, select Move Chart from the

Design tab. A dialog box will appear; select to place the chart in a new sheet 2"}::
and then name it appropriately (for example, ‘Cars by state’).

Location

. The chart will now have a separate sheet in the workbook. If you look at the worksheet names,

you will notice that the chart now appears there.

1

| Sheetl | Sheet2 | Cars by state | Sheetd | *

. If the data you want to include in a chart is not in adjacent rows and columns, use the Ctrl key to

make multiple selections in different locations on your worksheet.

. Trendlines can be added by selecting the Trendline tool from the Layout tab in Chart tools.
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Practice task 12

Create a spreadsheet, with the data below for Hemline Miller, showing sales, customer numbers and

quantities sold.

Hemline Miller

January report

Customer

Store Sales numbers
Chadstone 78009 567
‘Bundoora 95080 892
Wangaratta 120708 927
Seymour 110920 828
Newport 102787 998

1. Create a column chart that compares the sales data.

3. Create pie charts for sales, customer numbers and quantity sold.
4. Save your file as Hemline Miller January Report.

Quantity
sold
1298
2098
1792
1777
2143

2. Create a scatter chart that compares customer numbers with quantity sold.
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C Modify charts and layout

When working with charts, it is important to
understand how to make changes if they are
required. You can improve the appearance and ease
of understanding by using titles, axis labels, legends,
colour and changes to layout.

Format your chart

Once you have created a chart, you need to format it
to suit your organisational requirements and make
it easier to understand. This may include formatting
the data range, text and legend or adding a pattern
to the chart area. Look at the following example of a
chart and notice the different components that can
be formatted.

CHART TITLE DATA SERIES
January - Bird spotting
PLOT AREA

=

300
VERTICAL AXIS 250

100
50
Al David Esther Gowrie Helen Lee Maicolm Shari  Trudl  Yousef
Bird watchers
— Target SWS% —ACTUR] Sp0tS OFf month
HORIZONTAL
HORIZONTAL AXIS TITLE AXIS LEGEND

Each component of the chart can be formatted by selecting the item, right-clicking your
mouse to display the shortcut menu and then making formatting choices as appropriate.
You can also use the Chart Tool buttons.
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Formatting your chart

Once you have created a chart you will need to format it to suit your organisational
requirements. This may include formatting the data range, text and legend, or adding a
pattern to the chart area. The following steps show how to format a chart.

1. Open the spreadsheet with your chart.

2. Click inside any of the data series columns. Right-click your mouse and select Format
Data Series. You will see the following Format Data Series dialogue box.

Format Data Series IR

SERIES OPTIONS ¥
A N
SO Ol

4 SERIES OPTIONS
Plot Series On

® Primary Axis
Secondary Axis
Series Overlap + -27% 7

Gap Width ~ — | 219%

3. Click Fill and select Gradient fill, then choose a preset colour and click on Close. You
will notice that the data now has a shade effect in the chart. If you want to change the
look to something different, instead of selecting Gradient fill, select Picture or Texture
fill, and select an appropriate texture.

4. Repeat this process to choose Gradient fills for the other columns.

5. 'The Plot Area is the space behind the columns. The Chart Area is the space behind the
legend and the chart labels. Right-click in the Plot Area and select Format Plot Area.
The Format Plot Area dialogue box will appear. From Fill, select Solid Fill and choose
an appropriate colour. Click Close.

6. Right-click in the Chart Area and select Format Chart Area. The Format Chart Area
dialogue box will appear. From Fill, select solid fill and choose an appropriate colour.
Click Close.

7. To add a border to the Chart Area, right-click and select Format Chart Area. From the
Format Chart Area dialogue box, select Border colour, choose Solid Line and make the
colour black. Click Close.

8. To add a Chart title, select Chart Title and then Above Chart from the Layout tab.
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+ g CHART ELEMENTS Series Overla
= Axes Gap Width
& [ Axis Titles
Y Chart Title 4 Above Chart
Data Label
[ Data Labels Centered Overlay
[] DataTable .
D Error Bars More Options...
Gridlines
Legend
[] Trendline

9. To add axis titles to the chart, from the Layout tab select Axis Titles, and add a
horizontal title and vertical title.

10. To format the text in the Chart title, select the Chart Title, and use the formatting tools
on the Home tab.

11. To add data labels to the chart, select Data Labels from the Layout tab, and then select
an appropriate position in the chart (such as centre).

12. Format gridlines in the chart by right-clicking and selecting Format Major Gridlines.
Select Line Style and choose a dashed line style. Click Close.

13. The chart should appear similar to the following example:

Company Cars

N 7
u b
m 3}

5 H
b
e 4 S l E

3 3 3 3

o 2 : L
: @I u .

1 1
c 0 ﬂ-u —a.._ — . e bl .
: Ford Holden BMW Audi Mazda
; Make of car

= Meiboume Perth mSydney Adelaide
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Why format your chart?

You will need to format your chart to adhere to
organisational and/or task requirements. Formatting
the chart can also enhance presentation and the
information’s overall readability.

Balance the time taken in preparing the chart with
the required output medium. If you do not have

a colour printer, or are not presenting the charts
electronically, it will not be necessary to spend a lot
of time selecting colours and so on. You will only
need to ensure the font type and size is appropriate
and that the chart is well presented.

All parts of the chart are separate components and
can be formatted and adjusted as appropriate. To
select a part of the chart, point and click to select

it — then use the tool bar or right-click mouse shortcut menus to make appropriate changes.
Formatting of the chart can relate to colour choice, using gridlines, adding borders, adding
titles and labels, font size and type, and even changing the choice of chart type to be used.

Titles in a chart are separate objects and can be moved around and re-sized, by clicking and

dragging with your mouse.

Modifying a chart

A chart may need to be modified. This could mean changing the type of chart, changing the
range of data to be displayed in the chart or changing the formatting of the chart.

Formatting changes are done with the Chart Tools or by right-
clicking in the Chart Area or Plot Area. Once you insert a chart
into your worksheet, you will notice that two new tabs appear -
Design and Format.

Design tools

=
CHART TOOLS

DESIGN FORMAT

Design tools allow you to change the type of chart selected, adjust the style and layout,
alternate the view of data between row or column, and check or adjust the data selected.

i x —~ - - - = - 7
o os on @ B DD @ S ®i.3 2

Chant Type
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Chart styles tools

Chart Styles can be used to change the colours used in the chart.
January - Bird spotting

350
300

200
150
100

o &

Al David Esther Gowrie Helen Lee Malcolm Shani Trudi Yousef

Bird watchers

— T 3rget spots for month — ACtual spots of month

Chart layout tools

Chart Layouts can be used to change the way the chart is set out.

January - Bird spotting
m—Target spots for month — Actual spots of month

340

322 322

Ali David Esther Gowrie Helen Lee Malcolm Shar Trudi Yousef

Bird watchers
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Data tools

Data tools can be used to change the data range or adjust the way the data is presented in
the chart.

January - Bird spotting

Al David  ==—Esther Gowrie Helen

Lee MalCOoIM e Shari Trudi w— Y QUS €

Target spots for month Actual spots of month

Bird watchers

Type tools
Type tools can be used to change the type of chart presented.

January - Bird spotting

®m Ali mDavid = Esther B Gowrie B Helen B Lee W Malcolm B Shan = Trudi W Yousef

322 322 =30 |

213 :

| 180 187 - Ny

- 123 ‘ 1091 ‘

' 67 67 ‘
52 a 56

34 5 2 I 6 29 34 |

| = = i I

Target spots for month Actual spots of month

Bird watchers
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Layout tools

Layout tools allow you to add to and adjust the appearance of the chart by adding titles,
labels, gridlines and so forth.

.( CHART ELEMENTS
Axes
5 Axis Titles
Y Chart Title
Data Labels
[] DataTable
[] Error Bars
Gridlines
Legend
[] Trendiine
; | =
.g STYLE  COLOR ?
e S [a -
vl . e .g VALUES  NAMES
, 55:‘ , 4 SERIES 4]
: ikl _l I_'l i i [/ (Select All
" e < _ v B Al
JANUARY - SIRD SPOTTING . @ DaVid

050 S T St e Vi F T

. _ V] Esther

3 -
: N
’ = '
- B ZI 3 3P ‘I ’
a1 B ¢ —
i v!l | (I NS0 [v]
wetrzwmgmy Men o voue. A

1
f
y
[l B Gowrie
|
|
I
|

Helen
pplcrveamme AT
Mrzaroan
[Vl B Lee
IANUARY - BIRD SPOTTING
‘znnu:—A-wmla—---n-l¢rn\--|n- Tl W . i'?} Malco'm
iz 3 wr =]
e = e — vl B Shari
1 8 = = |
X - l.= >
w = =1 ) A | -
= =B gazg“ 2=z ~ M § Trudi ||
3o oot T ke s
Bevdden I i |
Lvi [l B Yousef
" t
4 (CATEGORIES
B ! o~ v

l Apply l Select Data...
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Analysis tools

Use the Analysis tools to add a straight line to compare individual results to the average.

January - Bird spotting

Al I David ( Esther I G Owrie
— Helen — e mmmmm Malcolm mmmw Shari
Trudi B Yousef & ceeeeeens Linear (Ali)
322 322 340

180 187 157

108.
67

Target spots for month Actual spots of month

Bird watchers

Background tools
Use the Background tools to format the plot area (right-click on area and select Format
Plot Area).

Format Plot Area a

PLOT AREA OPTIONS ¥
O QO

P FILL
> BORDER

Format Plot Area v %

PLOT AREA OPTIONS ¥
O Q

P SHADOW

I GLOW

I SOFT EDGES
I> 3-D FORMAT
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January - Bird spotting

o Al I David | Esther I G owrie
m Helen e mmmms Malcolm s Shari
! Trudi I Yousef &« ceeeeeees Linear [Ali)
322 322 340

157

--.o|||".., = =

Target spots for month Actual spots of month

Bird watchers

Axis tools

Use the Axis tools to add gridlines and axis information.

January - Bird spotting

Al  David s Esther I Gowrie
m— Helen e s Malcolm s Shari

Trudi I Yousef — ceeeesees Linear (Ali)

340

350 322 322

250
200
150
100

Target spots for month Actual spots of month
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Format tab =~ o
From the Format tab, use the Insert Shapes group to add shapes mlel®|E
and text, and the Insert tab, Illustrations group to add pictures and | Change
ine p group oadd picturesand. || A1 [+ G
online pictures.
Insert Shapes

350

250
200
150
100

50

January - Bird spotting

— Ali  David = % Esther B Gowrie
m Helen e = Malcolm s Shari
Trudi B Yousef  ceeeeeees Linear (Ali)
322 322 =40

157

67

Target spots for month Actual spots of month

Current selection tools

Use the Current Selection group to select the various components of the chart (such as a
chart title) and adjust their individual appearance.

350

250
200
150
100

50

January - Bird spotting
— Ali . David g W Esther I Gowrie
m— Helen L ce mmmem Malcolm s Shari
Trudi N Yousef — ceeeeeees Linear (Ali)
340

322 322

157

34
/M

Target spots for month Actual spots of month
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Format tools

Format tools enable you to alter the general appearance of the chart such as colours, font
type and font size.

- Hoas INSERY PAGE LAYOUY FTORMULAS DATA maw irw ACROZAT DERCN FORMAY

Chart Ares 23 Shape it - Baign- o

M S « 40 trs2em -
Y fomSeecton 1O - i | (| aee | Zomeouee A A A | & ,
I ResettoMuschSete O L L¥ o ¥ O Shope Effects < *| ) - % Selection Pane A e 123em
Curvest Solenn Yarn Vs Vage ey % Wargdn \rpte A Livarcge ey

For example, Size tools can be used to change the height and width of the chart, adjusting
the overall layout.

January - Bird spotting
— Al — David s Esther G owrie
—— Helen | ce s Malcolm  mmssmm Shari
Trudi . Yousef — ceoeeeens Linear (Ali)
400
350 322
300
250
i 157
150 109
100 67 67
50 29 34
0 ]
Target spots for month Actual spots of month

Arrange tools

Arrange tools can be used to display the selection pane, which enables you to hide or
display charts in the spreadsheet.

' G “ | ) LS L M n o » o
Selection e
Show A3 Mde -
Chani -

January - Bird spotting

— LRl L = Eslher e
— ==t e V0l — et
Trum — et Unear )
o
0 a2 i
30
%0 n
s ] = 157
150 e @
ey
o = =

Tanget spoes far momen Acrad aes af mones
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WordArt styling
WordArt Styles tools can be used to add effects to the labels within the chart.

January - Bird spotting

= Ali  David I Esther N Gowrie

— Helen — e memmm Malcolm  sessss Shari

Trudi B Yousef — ceoeeeen Linear (Ali)

ap0
350

300

200

157

150 109

100 67

< 29 34

Tarpet snots for month Actual soots of month

Shape styling
The Shape Styles group can be used to change the border image of objects in the chart.

January - Bird spotting

 David s Esther  Govirie
memen Malcolm  ssssss Shari

Linear (Ali}

157
108

56 67
29 34

Target spots for month Actual spots of month
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Practice task 13

Open the Hemline Miller January report document you created in Practice task 12. Format the
charts (using bright colours, gradients and textures) to include relevant titles and labels as follows:

1. Column chart, include the title ‘January - sales’.
2. Scatter chart, include the title ‘January - customer numbers vs quantity sold’.

3. Pie charts, including relevant titles for sales, customer numbers and quantity sold, as well as
data labels showing percentages of total.

Summary

1. A chartis a graphical representation of selected worksheet data.

2. Charts are visually appealing and make it easy to display comparisons, patterns and
trends in data.

3. The type of chart you choose to display data depends on organisational and task
requirements.

4. When you insert a chart, three Chart Tools tabs appear — Design, Layout, and Format.

5. Each component of a chart can be formatted and adjusted as needed.
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Learning checkpoint 4

Produce simple charts

This learning checkpoint allows you to review your skills and knowledge in producing
simple charts.

Part A

1. Write a short paragraph for each of these chart types explaining the type of data most
suited to each type:

o Pie

o Column
e Scatter

e Line

2. Use the data below to create charts as follows (save the spreadsheet to an appropriate
location and name it Jim’s Booksellers - January sales comparison):

o DPie chart to show percentage achieved for individual sales consultants.

o Column chart to show target and actual sales figures for individual sales
consultants.

o Scatter chart to show clusters of actual with percentage achieved.

o Line chart to show a comparison of target and actual for individual sales
consultants.

Unit release 1 (Aspire Version 1.1)

© Aspire Training & Consulting 121



BSBITU304
Produce spreadsheets

To calculate the percentage in the last column you need a formula that divides the actual
sales by the target sales, then multiplies that answer by 100.

Jim’s Booksellers
January comparison - target sales figures to actual sales figures

Sales consultant Target Actual Percentage of
target achieved
Amanda $80000 $71891
Geraldine $75000 $72910
Harry $68000 $62820
Jim-Bob $87000 $92192
Maureen $85000 $78282

Part B

Workplace learners can either complete this assessment using a spreadsheet with charts that
has been produced in the workplace or they can use the instructions below to complete the
assessment.

1. Open the spreadsheet Jim’s Booksellers - January sales comparison which you made
in Part A.
Format the charts as follows:

o Use the Design tab tools to make adjustments to layout and style. Make choices
according to your preference.

o Add data labels to the pie and scatter charts.

o Add gridlines, as appropriate, to the charts.

o Format the plot area using a gradient, as appropriate.

« Add a shape to the pie chart to identify the highest-achieving sales consultant.
o Use WordArt Styles to format chart titles.

o Use Shape Styles to apply dark borders around the charts.

o Preview your charts before printing on individual pages.
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You must ensure you are producing quality spreadsheets and charts that adhere to
organisational and task requirements. The final spreadsheet and chart must be thoroughly
checked and proofed before completion to ensure the correct message and company image
are delivered to the audience. Print previewing your spreadsheet and chart before printing
can save time and ensure the necessary adjustments are made before you print.

When preparing spreadsheets and charts you must comply with the required time lines
and job instructions. If you believe that either the time line or job instructions need to be
altered, you should discuss this with your supervisor or the person who has requested the
work. Many businesses have strict deadlines for completing tasks. Failing to meet deadlines
can have an impact on other tasks and teams within the organisation.

It is easier to access spreadsheets that have already been created by using appropriate file
referencing and saving options. Saving files in the correct location is important as it ensures
all interested parties can access the spreadsheet quickly and easily. It also saves time and
improves on business efficiency.

In this topic you will learn how to:

5A  Preview, adjust and print spreadsheets

5B Meet data input time lines and quality requirements

5C Name and store spreadsheets and exit applications safely
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5 A Preview, adjust and print spreadsheets

Previewing lets you check spreadsheet accuracy,
layout, presentation, consistency and readability. It
will save time and improve efficiency. It reduces
paper wastage.

When you are planning a spreadsheet task, you may
think that designing and creating your spreadsheet
is the biggest part of the job. Yet collecting, checking
and entering the data can take a long time. This part
of the process can cause delays, especially if you
need other people to contribute data. The data that
goes into your spreadsheet needs to be complete and
accurate enough to give the desired results.

Because there are so many files created in businesses,
and because staff change, you need to give files useful
names and store them in the right location. This makes it easier for people to find them
later on.

Part of the proofing process for finalising spreadsheets and charts is to preview them before
printing. Print Preview lets you check that the requirements originally specified have been
met and also allows you to check layout and overall appearance.

Preview and adjust spreadsheets

Previewing spreadsheets before printing is good practice and you should always do so.
As mentioned, previewing lets you check spreadsheet accuracy, layout, presentation,
consistency and readability. It will definitely save time and improve efficiency. By not
printing until you are certain the spreadsheet is ready, you will save paper, power and
print toner.

Print Preview function

Print Preview shows the selected spreadsheet or chart. If there is a chart as an object in the
spreadsheet it will appear as above. If, however, you have clicked on the chart object and
selected it, Print Preview will not display the data, it will only show the chart. Excel assumes
that if you have selected the chart only, that is all you want to print. If you want to preview
both the data and the chart, ensure the worksheet is active and not the chart.

If the chart is a separate sheet in the workbook and not an object with the data, to preview
the chart you will need to select the worksheet that it is contained in.

The default option for Print Preview is to preview only the current worksheet in view. If
you want to view the entire workbook, you need to select all worksheets. To do this hold
down the CTRL key and press each worksheet name with your mouse before selecting Print
Preview.

Be careful if selecting multiple worksheets. If you have a number of worksheets active at one
time, any data that you alter and input will be repeated on all of the selected worksheets. To
deactivate multiple selected worksheets, simply click on one worksheet name. This will then
become the active worksheet.
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Print Preview
To preview your spreadsheet or chart, go to the File tab and select Print.

The preview will be visible in the right-hand side panel.

Chapter 4 - 30 Fie chet - Erced

Settings

Prevt Actin Sheets

et 302 Corvger e

et e Terees foots Mo Ogana Prun
1 T s o »

Wealth Food Compuie

Print tools

From the Print screen you can do the following: 7
 print the workbook, spreadsheet or selection
« enter the number of copies you want to print
« select double-sided printing

o alter the orientation from portrait to landscape,
choose the paper size, adjust margins and
scaling.

Further Page Setup options are available by clicking
on the link below the Scaling drop-down menu.
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Print tools

Below the Print Preview there are buttons which allow you to:

view next and previous pages
zoom in or out on the spreadsheet

show margins of the document and, if needed, make manual adjustments by using
your mouse.

([L Jor3 » gl

To return to your Excel workbook, select the Back Arrow.

To preview margin settings:

1.

2
3
4.
5

N

Print spreadsheets and charts

Before printing, you need to decide what it is you
want to print — specific sheets, the entire workbook, a
selection of data or possibly just a chart.

When printing charts, you need to consider whether
you want to print the chart as an object in the
spreadsheet or whether you want the chart printed
on its own page.

Open a spreadsheet.

Preview the spreadsheet.

Use the Zoom button to view the data closer up.
Check the page orientation is set to landscape.

From the Page Setup dialog box select the Margins tab and centre the data horizontally
and vertically.

Use the Show Margins button to preview margin settings.

Close the preview.

126

Unit release 1 (Aspire Version 1.1)
© Aspire Training & Consulting



Topic5
Finalise spreadsheets

Print the active worksheet

1.
2.

Open a spreadsheet file.
Go to the File tab and select Print.

From Page Setup select Scaling of 135 per cent. Scaling allows you to adjust the size of
the print-out, making it larger or smaller on the printed page.

The first drop-down menu under Settings identifies what is to be printed and will show
active sheets. From the drop-down menu you can choose to print the entire workbook
or a selection of cells. Alter the printer that you are printing to if needed, and select how
many copies you want to print. It is also possible to alter how the multiple printed copies
are collated. When you are ready to print, click the Print button.

=l Copies: |1 :
Open =

Print
Save
Save As Printer

@ __/ Pubs_Printer on atcservl

Save as Adobe g . Read

PDF ===

Printer Properties
Print >
Settings

."1'

Share

Export Print Active Sheets

Only print the active sheets
Close

Print Entire Workbook
Print the entire workbook

Print Selection
Only print the current selection

Account

Options

Ignore Print Area
' D Ad (210 x 297mm)
Zl} cm )_(_29._7 cm
[ i"" Normal Margins <
| 2=t Left 1.78 cm Right: 1.78 cm

(M9 NoScaling
(o0

Print sheets at their actual size

-

Page Setup
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Printing formulas

If you want to print formulas entered in a worksheet,
go to the Formulas tab and select Show Formulas
from the Formula Auditing grouping.

When in Print Preview, use Fit to in Page Setup to fit
your worksheets on one page or a number of pages.

Print a selection from a worksheet

You may be dealing with a very large worksheet
or your manager may have requested only some
information from a worksheet. If this occurs you
may need to print only part of a worksheet.

1. Open a spreadsheet.

2. Select the cells you wish to print.

3. From the File tab select Print.

4. From the first drop-down menu under settings choose Print Selection.
5

The preview should now look similar to the following example.

Store Sales

Chadstone 78009
Bundoora 95080
Wongaratta 120708
Semour 110920
Newport 102787

6. Click the Print button.

Print a workbook

To print an entire workbook comprising multiple worksheets, follow the instructions for
printing a selection, but from the drop-down menu select Print Entire workbook.
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Print a chart

1. Open a spreadsheet file containing a chart.

2. Select the chart by clicking on it. Because this is selected only the chart will be
previewed and not the data in the spreadsheet.

3. From the File tab, select Print. Your chart will be displayed exactly as it will be printed.
Click the Show Margins button and manually adjust the left and right margin by
clicking and dragging with your mouse.

4. Notice that Print Selected Chart is automatically selected. Alter the printer that you are
printing to if needed, and select how many copies of the chart you want to print. Click

the Print button.

©

New
Open
Save
Save As

Save as Adobe
PDF

Print
Share

Export

Account

Options

5. Save and close the file.

O Copiess |1 =
Print
Printer
@ __; Pubs_Printer on atcservl
[oe: Pesdy
Printer Properties
Settings

l 77 Print Selected Chart
= Only print the selected chart

- -

Pages: v to | x
Print One Sided
“—j Onlryrprlnt on one side of th... ¥
@ﬁ Collated .

123 123 123

Portrait Orientation -

Letter (8.5 x11")
2159 cmx 2794 cm

7 | [

‘l l Normal Margins g
Left 1.78 cm Right: 1.78 cm

I

Page Setup

You can adjust the size of the print-out by altering Adjust to more than 100 per cent of
normal size in the Page Setup dialog box. Page Setup is available when you select Print from

the File tab.
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Follow organisational requirements for printing

A workplace normally has standards for staff to adhere to when printing. These could
include using recycled paper when printing for the first time, which enables you to check
a draft copy before printing the final copy. A workplace practice of using Print Preview to
proof spreadsheets before printing can help to save paper.

Organisational and task requirements may specify things like the number of copies. You
may be required to print a master copy and then use the photocopier to make additional
copies. This is particularly important with longer spreadsheet reports and charts, as you
may be able to use the double-sided copy option available on the photocopier.

When preparing to print you need to ask yourself the following questions:

o What do I need to print - workbook, active spreadsheet, selected data, chart?

o Did I preview before printing?

o [Ifitisa draft spreadsheet, did I print on recycled paper?

« How many copies of the spreadsheet do I need?

o Should I use the photocopier for multiple copies?

Practice task 14

The following tasks require you to access the Hemline Miller January report you worked on in
previous practice tasks.

1. Open the file Hemline Miller January report.

* Preview the spreadsheet. Check the appearance of the data and charts and make any
necessary adjustments before printing.

* Print one copy of the spreadsheet.
* Close the file.
2. Open the file Hemline Miller January report.
¢ Select cells A4 to B9 - this will select only the store and sales data.
* Print only the selected data.
¢ Close the file.
3. Open the file Hemline Miller January report.
¢ Select the column chart only.
e Print the chart.
* Close the file.

4. From your Hemline Miller January report spreadsheet, print out the Store and Sales columns.
Adjust the size of your selection until it is 150 per cent of normal size.
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Meet data input time lines and

quality requirements

Getting the data ready and then entering it into your
spreadsheet may actually be quite a significant task.
There’s little point in having a spreadsheet ready
three days before a meeting if it is going to take a
week to collect, check, enter and re-check the data.

There are some standard ways to help meet time lines
for data entry and to meet the accuracy requirements
for the particular task.

Meet time lines

Whenever you are given a work task, you need to
plan a time line. A time line breaks the task into steps
and details when each step must be completed.

Find out when the spreadsheet is required and enter the date in your diary. Identify and
plan the task requirements to work out how long it is likely to take. Careful planning is
necessary to avoid a last-minute panic. If you are developing a spreadsheet for someone else,
always clarify exactly what is required; for example, are formulas needed and do you have
to create a new column? If you have to write formulas, make sure you allot enough time to
have them checked by your manager.

If you are relying on others to provide you with data, then you need to allow for this. You
should plan on giving reminders and follow-ups so others do not delay the whole project.

Prepare a checklist

Preparing a checklist can help you plan a work task. Creating spreadsheets will become
easier once you are familiar with your organisation’s requirements. Look at the following
example of a checklist.

Create a Tuesday » Collect the product data v
spreadsheet | 20 March «  Check the data

for manager
* Enter the data

» Proofread the data

» Format the spreadsheet using organisation’s style
guide

» Create a new column named Interest

«  Write a formula to calculate 10 per cent of
customers’ balances

» Create a column named Sale Price
»  Write a formula to calculate the new sale price
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Organisational time lines

You will often be required to meet specific deadlines in a workplace. You may be instructed

by your supervisor as to the deadline for completing set tasks; for example, preparing a draft
summary report by 2.00 pm. You may also have regular deadlines for common tasks such as
on a monthly basis, creating a report of customers who are overdue in paying their invoices.

You may find you have conflicting work priorities and time lines. In these situations, your
supervisor may be able to help you by suggesting ways to meet the deadline or they may be
willing to adjust the deadline.

Achieve time lines

Using a diary system and a to-do-list can help you
prioritise tasks and stay aware of the time lines
required for set tasks.

If you are asked to complete a task, always ask
what the deadline is. If you have a high workload
at present, ask if the deadline is definite or able to
be negotiated. In many cases, there will be room
for negotiation. If it cannot be negotiated, explain
to the person making the request, or discuss with
your supervisor, your conflicting priorities. Try to
work out a happy medium or see if they are able

to offer some additional assistance for you to meet
other deadlines. Your supervisor may be able to pass
some of your other work onto another colleague to
complete.

Always ensure that the time line set is realistic and achievable and, if there are any
problems, that you discuss these with your supervisor or the person who requires the
spreadsheet.

Accuracy of data

The quality of the outputs from your spreadsheets will depend on the quality of the data
going into them. Remember ‘GIGO’ - garbage in, garbage out?

You must ensure that the data being entered is good enough to do the job required; for
example, if the manager wants percentages to the nearest 1 per cent and your data is very
rough, then the answers you provide may be meaningless.

Not only does the data have to be accurate enough, it also has to be entered accurately.
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Practice task 15

Read the case study, then answer the questions that follow.

Crystal works as an administrative officer for a local government agency’s conference

and meeting centre. Her role involves coordinating the bookings for the centre, as well as
maintaining an adequate supply of stock and resources for the centre’s clients. Crystal’s
supervisor has asked her to produce a report by the end of the day summarising all the clients
that have used the centre in the past 12 months, along with a chart that shows the percentage
of their usage. Crystal, being quite easy-going, said ‘no worries’ and went about her daily tasks
as usual. She allowed herself the last hour of the day to prepare the report and chart. When
Crystal began preparing the report and chart, she realised that it was a much bigger job than
she had anticipated. The current system provides information in a folder and is more of a paper
trail of information. Crystal realised she needed a lot more time to compile the information for
her supervisor.

1. What should Crystal do?

2. What could Crystal have done differently when agreeing to the deadline for the task?
3. How important is the data-gathering component of this task?

4. What does the task actually require Crystal to do?
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5 Name and store spreadsheets

and exit applications safely

You need to follow any requirements of your
organisation for naming and storing spreadsheet
files. This will make it easier for you and your
colleagues to retrieve spreadsheets when needed.
Some organisations have strict naming standards
that must be adhered to, such as all project files
having to start with PRO. Another example is using
product codes rather than descriptions. It is better to
use a product code as this is individual, whereas
there may be many products with similar
descriptions, so it can become confusing. Find out
the naming standards for folders and files in your
workplace or place of study.

When you have a spreadsheet stored in a folder, it

must have a unique name in that folder. No two spreadsheets stored in the same location
can have the same name. Excel will let you know if a file with the same name already
exists, and you will have to save the file using an alternative name. If you are not sure of the
procedures for saving and storing, ask your supervisor.

When closing Excel, always follow procedures and exit correctly. This ensures the data you
have entered into the spreadsheet doesn’t become corrupted and unusable the next time the
spreadsheet is used.

Name your spreadsheet

As well as placing folders and files in the appropriate place, you also need to give them
appropriate names. Naming methods need to be kept consistent, simple and meaningful.
The file name you choose may include any combination of numbers or letters. Some
characters cannot be used in filenames, including: ., / \ * ? <. Appropriate naming
conventions help people identify and retrieve files.

When saving, Excel automatically adds a file extension to your spreadsheet. The file
extension identifies the type of program that the spreadsheet has been created in, and tells
your computer system what program to use when opening the file again. In Excel 2013 and
2010, all spreadsheets are saved with the extension .xlsx. For earlier versions of Excel (that is,
1997 to 2003), the extension is .xls.

Create a spreadsheet to be used by previous versions
of Excel

Excel 2013 has some features that are not available in previous versions. If you are creating
a spreadsheet that others need to access electronically with a version older than Excel 2007,
you will need to work in compatibility mode. Compatibility mode turns off some of the
new features, which ensures that people working in older versions will have full editing
capabilities.

To save a spreadsheet in compatibility mode, go to the File tab, select Save As, and select
Excel 97-2003 Workbook in the Save As Type list.
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Authorised access

Many organisations have protocols in place whereby
you can only access those parts of the shared network
that are relevant to your work or your department.

Authority to access various parts of the shared o‘d
network are provided by the organisation’s systems P assw

administrator. If you do not have access to a part of
the shared network that you need access to, discuss
this with your manager.

It is also possible to limit access to spreadsheets ‘ ’
that you create by the use of passwords. Passwords ’
are commonly used for spreadsheets that contain

confidential, private or sensitive information;

for example, profit analysis or staff information.
Passwords can be used to limit access to opening
spreadsheets or to limit the ability to modify information in the spreadsheet. Follow the
steps below to place a password on a spreadsheet to limit access to opening the spreadsheet.

1. Open a spreadsheet.

2. From the Office button, select Save As.

3. From the Save As dialog box, select the Tools button.
4. Select General Options from the available menu.
5

Type in a password to open (ensure the password you choose is one that you will easily
remember), and select OK.

6. You will return to the Save As dialog box, select the Save button. (If an error message
appears stating that there is already a file with that name existing, do you want to
replace existing file? Select YES. This will override the current file and replace it with
one with a password.)

7. Close the spreadsheet.

8. Practise opening the spreadsheet. You will need to enter your password to open it.

Organisational policy for backing up files

Many organisations have set procedures for the backup of files. In many large organisations
this is administered through the information technology department and is an automatic
process. In this case, the only thing you need to do is save your files to the appropriate
network drive and folders.

In smaller organisations, it may be necessary for you to backup files. This may be done on a
daily or weekly basis. You may have to backup files to CD or to another disk drive. If this is
the case, check with your supervisor for the relevant backup procedures.

Backing up files is an important practice as it helps to prevent the loss of documents and
information, and is extremely useful if something happens to the network or computer
system and you still want to be able to retrieve previous documents.

USB memory sticks are also useful for storing and backing up information, especially when
you require a portable copy of the information.
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Organisational policy for filing hard copies of
spreadsheets

It’s common for spreadsheets stored digitally to

also be stored in hard copy. This guards against a
computer system failure. Hard-copy storage requires
space and the establishment of a filing system that
uses consistent, simple and meaningful names,
similar to digital storage.

Hard-copy spreadsheets must be kept up-to-date.
Hard-copy spreadsheets need to be managed well
since storage space is often scarce and valuable. Old
or superseded spreadsheets must be destroyed on a
regular basis. Retention schedules list the time frame
that spreadsheets need to be kept before they can be
destroyed. Spreadsheets without permanent value
may be scheduled for eventual destruction. Find out
what kind of hard-copy filing system is used at your workplace or place of study.

Storage security

Information is a valuable asset in any organisation. How information is stored and the
security measures used to protect it are central to an organisation’s procedures.

The spreadsheets you create will usually be stored on a server that allows access to multiple
users. A server is a computer that delivers information and software to other computers
linked by a network.

To enable staft to log on to a server, the systems administrator issues each person with a
username. The user must then create a password. Usernames and passwords:

o give users access to the information they require to complete workplace tasks
o allow users to have different levels of access to information.

You may find that some of the spreadsheets you work with are confidential. Ask your
manager for your organisation’s policies regarding confidential material.

Safeguard data

Data also needs to be safeguarded against accidental or deliberate damage. Data loss is
usually caused by human error or system failure. Many organisations use a data cartridge
or cloud-based solutions to backup information on a database. If any damage occurs to the
server, or the premises, a complete information backup is available.

A server is made up of many files and folders. Organising this information helps users find
what they want. If you are saving information onto a server, make sure you know where to
put it. Ask about your organisation’s policies regarding the storage and security of Excel
files. The following case study shows the importance of always backing up data.
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Exiting the application safely

After creating or modifying a spreadsheet, you need to exit the software application without
causing damage or data loss. Data loss occurs when a computer program stops performing
its expected function. Often the program or even the whole computer may appear to ‘freeze’.
All computer users will experience data loss at some time. Data may have been accidentally
erased or corrupted and made inaccessible.

To exit the spreadsheet program, click the exit button *, which is located in the top right
corner of the window. If you have recently made changes to your spreadsheet, you will be
prompted to save changes.

Here are some precautions you can take to prevent data loss.

Precautions to prevent data loss
Try to work on only one spreadsheet at a time.

Data loss can occur if someone else tampers with your work. If you are working
on a spreadsheet at your workstation, you need to lock your computer or exit the
application before leaving your workstation unattended.

If you need to work with multiple applications open, make sure you close
applications that are no longer needed. This will help your computer work more
quickly and will prevent data loss in the event of computer failure.

If your computer starts to behave in an unusual way, save your work and shut it down
immediately and do not turn it back on until you get assistance.

Make sure your computer has an up-to-date anti-virus, anti-spyware and firewall
program to protect it against malware from the internet. Check also that it has the
latest security upgrades.
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Practice task 16

Read the case studies, then answer the questions that follow.

Matthew works as an office administrator in a large organisation. His duties include formatting
reports and saving them on the server. He is also responsible for backing up the server at the
end of each day. At the end of a busy day, Matthew had completed several reports for different
departments within the organisation. He had to save each of them in a different location,

and it took him a while to work out where they all belonged. He wasn’t sure if he had saved
them all in the correct place. After this, he was running late and decided not to back up the
server. The next morning, the reports that Matthew had saved were needed for an important
board meeting. However, during the night a virus had infected the server, destroying all the
information from the previous day.

Fred has retired from an organisation after working as an administrative assistant for 10 years.
The areas Fred was responsible for were accounts and projects. The day after he retired,
someone needed a file that Fred had created and stored. The file contained vital accounting
information. It was discovered that Fred had saved more than 500 files in a variety of folders
and the file could not be located. The folders had ambiguous names such as Folderl and
Folder2 and the files had names such as augustl.doc and march2.doc.

1. What would be the consequences if Matthew did not save some of the reports in the correct
place?

2. Can you think of any consequences of not backing up data on the server?

3. Describe why Fred’s folder and file naming system failed.

continued ...
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... continued

4. Fred was responsible for two areas. What could he have done to make sure files could be easily
located?

5. Explain why folder and file names should be consistent, simple and meaningful.

Summary

1. You should always preview your work before printing.

N

Make sure you have formatted, checked all formulas and functions and proofread your
spreadsheet before printing.

Working within a designated time line means you must plan your work.
Collecting, checking and entering data can be a big part of the task.
It is possible to print a whole spreadsheet or parts of a spreadsheet.

A chart can be printed on its own or as part of a worksheet.

N oo W

You need to understand your organisation’s policies and procedures on saving and
storing spreadsheets.
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Learning checkpoint 5

Finalise spreadsheets

This learning checkpoint allows you to review your skills and knowledge in finalising
spreadsheets.

Part A

1. Using the data below, create a professionally presented spreadsheet and appropriate
chart to compare daily rainfall for each year.

2014 2015
1 January 23 34
2 January 25 41
3 January 34 42
4 January 37 20
5 January 42 23
6 January 19 24
7 January 20 33

2. Print your spreadsheet on one page — landscape page orientation, incorporating the
chart as an object of the spreadsheet.

3. Save the spreadsheet to an appropriate location, and name it Temperature 10-11.

4. Use the checklist below to ensure that you adhered to requirements for finalising your
spreadsheet.

Data entry Accuracy of data input

Data formatting Formatted professionally — appropriate use of styles, colour, font
type, font size, bold, italic, underline, borders, shading, alignment

Chart Chart inserted as an object
Selected chart meets analysis requirements

Formatted professionally - appropriate use of layout and styles,
colour, labels, titles, borders

Save file Saved as name: Temperature 10-11
Saved to appropriate file location - drive and folder

Print Preview Print Preview to check data, layout and overall presentation
Landscape orientation

Spreadsheet data and chart on same page

Any required adjustments to content, layout, appearance made

Print Preview again

continued ...
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... continued
Task What to check for v
Print Print single page to selected printer
Exit Excel Exit Excel ensuring all work is saved appropriately
Adhere to task Followed instructions

requirements

End result: One page print-out - spreadsheet data and chart,
professionally presented

Meet designated
time lines

Able to meet designated time line (one hour) or as negotiated with
workplace manager

Negotiate extension to time line if needed

Part B

Write down your answers to the following questions:

1. What can you do to improve your speed and accuracy when working with spreadsheets?

2. Why is it good practice to preview before you print the final spreadsheet?

3. What tools and systems should you use to ensure that you meet time lines?
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4. What do you do to name and store your spreadsheets to ensure easy access in the
future?

5. What can you do to prevent loss or damage to your spreadsheets?

Part C

Use the following data to create a professionally presented spreadsheet and chart that
compares target stock supply with actual stock supply.

Save the spreadsheet to an appropriate location and name it Our Office 2 U - January

stock supply.
Our Office 2 U - January stock supply
Target vs actual
Product code Target Actual Percentage of target
that was achieved
PC239 4000 4309
PC340 3000 2987
PC401 2500 1076
PC509 4300 4109
PC617 3800 4026

Include the following components in your spreadsheet:
o Header stating today’s date

« Footer stating the file reference details

o Chartlegend, chart title and axis titles

o  Blue font, Arial, 10 point
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Make other appropriate formatting choices to ensure the spreadsheet and chart are
professionally presented. These should include:

« Landscape orientation

« Centring the spreadsheet on page - horizontally and vertically

Make sure you:
o preview before printing - print the spreadsheet and chart on separate pages.

o save to an appropriate location and name the spreadsheet Our Office 2 U - January
stock supply

o exit the program ensuring that all files have been saved as appropriate.
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